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Safety: Read first

Before installing this product, read the Safety Information.

Antes de instalar este produto, leia as Informações de Segurança.

Před instalací tohoto produktu si přečtěte příručku bezpečnostních instrukcí.

Læs sikkerhedsforskrifterne, før du installerer dette produkt.

Ennen kuin asennat tämän tuotteen, lue turvaohjeet kohdasta Safety Information.

Avant d'installer ce produit, lisez les consignes de sécurité.

Vor der Installation dieses Produkts die Sicherheitshinweise lesen.

Prima di installare questo prodotto, leggere le Informazioni sulla Sicurezza

Lees voordat u dit product installeert eerst de veiligheidsvoorschriften.

Les sikkerhetsinformasjonen (Safety Information) før du installerer dette produktet.

Antes de instalar este produto, leia as Informações sobre Segurança.

  
 

Pred inštaláciou tohto zariadenia si pečítaje Bezpečnostné predpisy.

Antes de instalar este producto lea la información de seguridad.
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Läs säkerhetsinformationen innan du installerar den här produkten.

Registering your option

Thank you for purchasing OPTIONS by IBM. Please take a few moments to register
your product and provide us with information that will help IBM to better serve you in
the future. Your feedback is valuable to us in developing products and services that
are important to you, as well as in developing better ways to communicate with you.
Register your option on the IBM Web site at:

http://www.ibm.com/pc/register

IBM will send you information and updates on your registered product unless you
indicate on the Web site questionnaire that you do not want to receive further
information.

About this book

This manual contains information on the IBM 4X/8X/32X CD-ReWritable Internal
IDE Option Kit. It is divided into the following parts:

Part 1: Installation and usage instructions in the following languages:

� English
� German
� French
� Italian
� Spanish
� Brazilian Portuguese
� Japanese

Part 2: Device driver special configuration settings, problem solving, help and
service information, warranty, and notices

Note:  The illustrations in this manual might be slightly different from your hardware.
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Part 1: Installation and usage guide

This part of the manual consists of an introduction, installation instructions, and
instructions for using and maintaining the CD-RW drive.

 Introduction

This section will give you a description of this option and the software which comes
with it, as well as some information you will need before you install the option.

 Product description

The IBM can write and read CD-RW (CD-ReWritable) and CD-R (CD-Recordable)
discs, and can read mass-produced stamped CDs. As a result, CDs created by this
drive are compatible with MR (Multi-Read) CD-ROM and DVD-ROM drives that can
read CD-RW discs and other media types, and with older non-MR CD-ROM drives
that can read only CD-R and CD-ROM discs.

The drive writes to CD-RW and CD-R discs at different speeds. The drive can write
to a CD-RW disc at up to four times the standard CD-ROM speed, recording data at
up to 1200 KB1 per second. At this rate, the drive can record approximately 650 MB2

of information on a CD-RW disc in about 18 minutes. The drive can write to a CD-R
disc at up to eight times the standard CD-ROM speed, recording data at up to 2400
KB per second. At this rate, the drive can record approximately 650 MB of
information on a CD-R disc in about nine minutes. The drive can also read data at up
to 32 times the standard CD-ROM speed, or 9600 KB per second.
Note:  To use the drive’s CD-recording function, you must install the Easy CD

Creator/DirectCD software (included) for Microsoft Windows 98, Windows
95, or Windows NT 4.0. For more information on the Easy CD
Creator/DirectCD software, see “Software description” on page 1-2.

The IBM can be installed only in a computer that uses the integrated drive electronics
(IDE) or the enhanced IDE architecture.

In addition to this book, the option kit includes:

� CD-RW drive
� Two audio cables
� Four mounting screws (M3 x 5 mm, slotted)
� IDE cable
� Two faceplates3 for use with certain systems

1 KB equals approximately 1024 bytes when referring to data transfer speeds.
2 MB equals approximately 1 000 000 bytes when referring to storage capacity.
3 If you purchased the black option kit, you will receive one black faceplate.
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� Blank CD-RW disc
� Blank CD-R disc
� Adaptec Easy CD Creator/DirectCDdisc
� IBM Option Diskette
� Laser Safety Guide for CD-ROMs
� Electrical safety booklet

Contact your place of purchase if an item is missing or damaged. Be sure to retain
your proof of purchase. It might be required to receive warranty service. See
Appendix D, “Help and service information” on page 2-20 for technical support
information.

 Software description

The Adaptec Easy CD Creator/DirectCD CDcontains programs that work with
Windows 98, Windows 95, Windows 2000, and Windows NT Workstation 4.0. You
can use the programs with your CD-RW drive to create audio and data CDs, to copy
CDs, and to make jewel case inserts or CD labels. This manual will give you basic
instructions on using the software so that you can get started creating CDs. Additional
information about the software and how to use it can be found in the online user’s
guide on the software disc.

The IBM Option Diskettecontains device drivers for Windows 98, Windows 95,
Windows NT 4.0, Windows 3.x, OS/2, and DOS that enable you to access the drive
as a CD-ROM drive in DOS mode. The diskette also includes an audio CD-player
program for DOS and a diagnostic program.
Note:  The software included in this option kit does not enable the drive’s

CD-recording capabilities with DOS, Windows 3.x, or OS/2 operating systems.

Before you begin

Read the following information before you start your installation.

You must complete the following steps to install the drive:

1. Determine which IDE port to use and the corresponding configuration setting.
2. Place or change the configuration jumper on the drive (and possibly make

changes to the configuration jumpers of other devices).
3. Install the drive in a drive bay.
4. Configure the system.
5. Install a device driver.

If you do not understand these procedures or are unsure about your ability to perform
all the procedures described, have a qualified computer technician install the CD-RW
drive for you.
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 System requirements

Before you begin installing the drive, be sure your computer meets the following
system requirements.

� Minimum microprocessor: IntelPentium processor (or the equivalent)
� Minimum RAM: 16 MB4

� 3.5-inch diskette drive
� Available IDE connection
� Available internal power connection
� Available drive bay
� One of the following operating systems:

– Microsoft Windows NT Workstation 4.0
– Microsoft Windows 95 or Windows 98
– Microsoft Windows 2000

You may need a flathead or phillips screwdriver to complete the installation. You
may also need to refer to the documentation that comes with your computer. Be sure
to have the documentation available.

 Handling instructions

To protect your CD-RW drive during installation, observe the following precautions:

� Handle the drive with care. Dropping or jarring the drive can damage the
components inside the drive housing.

� Keep the CD-RW drive in its antistatic bag until you are ready to install the drive
in your computer. Limit your movement. Movement can cause static electricity
buildup.

� Do not force insertion of the power cable. Doing so might damage the connector
or the drive.

4 When referring to memory storage capacity, MB means approximately 1 000 000 bytes; total
user-accessible capacity may vary depending on operating environment.
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Front view of the drive

Refer to the illustration to identify parts that might be referred to in the installation
instructions.

.1/ Headphone jack
This jack provides audio output to the headphones.

.2/ Volume control
This dial controls the headphone volume.

.3/ CD tray
This tray is where you load and unload a CD.

.4/ Busy indicator
This light comes on when the drive reads from, writes to, or plays a CD.

.5/ Manual-eject hole
This hole provides access to the eject mechanism to remove a CD from the drive.

.6/ Eject/Load button
This button opens and closes the CD tray when you push it.

Back view of the drive

Refer to the illustration to identify parts that might be referred to in the installation
instructions.

.1/ Reserved
 

.2/ Audio-out connector
This port connects the CD-RW drive to a sound adapter.
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.3/ Configuration pins
These pins are used to set the drive configuration.

.4/ IDE connector
This port connects the CD-RW drive to the IDE cable.

.5/ DC-power connector
This port connects the CD-RW drive to the computer power supply cord.

Installing the drive

Follow these steps to install the CD-RW drive into your computer.

Step 1. Opening the computer

1. Turn off the computer and all attached devices.
2. Unplug the power cords for the computer and all attached devices.
3. Remove the cover from the computer.

Step 2. Unpacking the drive

1. Before opening the antistatic bag that the drive is packed in, touch it to an
unpainted metal surface for at least two seconds. This drains the static electricity
from the package and your body.

2. Remove the drive from the bag.

If you must put the drive down, place the antistatic bag on a flat padded surface,
such as a magazine, and place the drive on the antistatic bag.

Step 3. Selecting an IDE port

Newer computers typically have two IDE ports, each of which can support two
devices. Typically, the IDE port connected to your hard disk drive is the primary IDE
port. The other IDE port is the secondary port. The IDE port and the cable position
that you select determine which configuration jumper setting you use for the drive.

� If you have two IDE ports, connect the CD-RW drive to the secondary IDE port
on your system board or IDE adapter. If the CD-RW drive is the only device on
the secondary IDE port, use the master configuration setting. If the CD-RW drive
is the second device on the secondary port, use the subordinate (or slave)
configuration setting.

� If you must attach the CD-RW drive to the primary IDE port (the same port as a
hard disk drive or other fast device), use the subordinate setting for the CD-RW
drive and the master setting for the faster device. In some instances, you might
need to change the hard disk drive configuration setting to
master-with-subordinate-present when attaching a subordinate device on the same
cable. For further information on setting configuration jumpers on other devices,
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refer to the documentation that comes with your computer or with the device in
question.

� Some non-IBM computers support the cable-select setting, where the position of
the device on the cable determines whether a device is master or subordinate.
See the documentation that comes with your computer to determine if your
computer supports this setting.

Step 4. Setting the configuration jumper

The illustration shows the master .1/ setting, the subordinate (or slave) .2/ setting,
and the cable-select .3/ setting. Configure the CD-RW drive by placing the jumper
over the set of pins corresponding to the setting you chose in “Step 3. Selecting an
IDE port.”

� If you are configuring the CD-RW drive as master, set the jumper to the master
.1/ device setting. (This is how the drive is set when it is shipped.) If there is a
second device on the IDE port, make sure that device is configured as
subordinate.

� If you are configuring the CD-RW drive as subordinate, set the jumper to the
subordinate .2/ device setting. Make sure that the other device on the IDE port
is configured as master (or master-with-subordinate-present).

� If you are configuring the CD-RW drive as cable-select, set the jumper to the
cable-select .3/ device setting. If there is another device on the IDE port, make
sure that the second device is also configured for cable-select.

Step 5. Mounting the drive in the bay

Attention:  Be sure to use the M3 x 5 mm mounting screws in the option
package. Using screws that are too long might damage the drive.

You can mount the CD-RW drive horizontally or vertically in the computer. If you
mount the drive vertically, you must secure any CDs you place into the drive before
the drive tray is closed, or the CD-RW drive will not be able to read the CD properly.
For further instructions on securing your CDs in a vertically mounted drive, go to page
1-12.
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1. Slide the drive into the bay. Your computer might have specific required
procedures for installing storage devices. Refer to the documentation that comes
with your computer for further instructions.

2. Align the drive-bay screw holes with the threaded holes in the drive housing or
mounting bracket; then thread the screws in loosely to check their positions.
Usually two screws are used on each side.

3. Check to make sure the alignment is correct; then tighten the screws to secure the
drive. Do not overtighten.

Step 6. Attaching the cables to the drive

Connect the cables to the CD-RW drive as follows.

1. If you want to connect the CD-RW drive to your sound adapter or to the sound
function on your system board, locate the included audio cables and determine
which cable best fits the CD audio-in port on your sound adapter. Connect one
end of the selected audio cable to the CD-RW drive audio-out connector .1/, and
the other end of the cable to your sound adapter CD audio-in port. Save the other
cable in case you use a different sound adapter in the future.

2. Attach a 40-pin IDE-cable connector .2/ to the IDE connector on the drive.
Align the cable so that the color-coded edge is closest to the power cable
connector .3/. Use the IDE cable provided with this option if there is no cable
attached to the IDE port or if there is only one device connector on the IDE
cable. If you use the included IDE cable, attach one end of the cable to your
system board IDE port or to your IDE adapter, and the other end of the IDE cable
to the CD-RW drive.

3. Locate one of the available power cords attached to your computer power source.
Attach the four-pin power cable .3/ to the CD-RW drive dc power connector.
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Step 7. Completing the hardware installation

1. Be sure that the drive is securely mounted and the connectors are firmly attached.
2. Be sure that the cables do not interfere with the computer cover and do not block

the power-supply fan blades or air-flow paths.
3. Reinstall the computer cover.
4. Reconnect all devices and check any devices that might have become

disconnected, such as the keyboard, mouse, and monitor.
5. Plug all power cords into electrical outlets.

Step 8. Attaching the faceplates

This option package includes two faceplates that conform to the curved design of
certain computers. If your computer has a curved design, you can attach one of the
included faceplates so that the front of the CD-RW drive matches the exterior cabinet.
Choose the faceplate that best fits your computer, and attach it after you have mounted
the CD-RW drive in the appropriate bay.
Note:  Depending on the exterior design of your computer, you may need to attach

the faceplate before placing the cover back on your computer.

Step 9. Updating your computer configuration

After you have completed the hardware installation, restart your computer. Usually,
the configuration-setup information screen is displayed. If this screen is not displayed,
check your computer documentation for information about accessing the configuration
or setup utility program.

To see the configuration information for most IBM computers, press F1 during startup.
When you have finished reviewing the information, save the changes and exit.

Note:  Some older computers with one IDE port might not display the CD-RW
drive information when you review the configuration-setup information. You still
can use the CD-RW drive in this situation if you have properly completed the
installation.

Step 10. Installing the (optional) DOS device driver

Note:  This device driver is not necessary to use the CD-RW drive with most
operating systems. It is only necessary if you plan to use the CD-RW drive as a
CD-ROM drive with DOS, or you need to access the CD-RW drive using a DOS
prompt. Be sure to see the READ.ME file on the Option Diskette for the latest
information about the software on the Option Diskette.

The IBM Option Diskettecontains device drivers that allow you to access the CD-RW
drive from a DOS prompt.
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To install the IBM Option Diskette device drivers for Windows 98, Windows 95,
Windows 3.x, OS/2 or DOS:

1. Insert the IBM Option Diskette into the diskette drive.
2. Type A:CDSETUP in a command line and press Enter.

 3. Click Setup.
4. Follow the on-screen instructions to install the software.
5. Click Exit  after software installation completes.
6. Restart your computer so the new settings take effect.

Windows NT 4.0 will automatically detect the presence of the drive. No additional
steps are required to activate the device drivers.

For optional information about configuring the IBM Option Diskette device drivers for
Windows 3.x, DOS, OS/2, Windows 98, and Windows 95, go to Appendix C,
“Customizing device driver configuration settings” on page 2-13.

Step 11. Installing the Easy CD Creator/DirectCD software

Note:  Be sure to see the README file for the latest information about the Easy
CD Creator/DirectCD software.

The Easy CD Creator/DirectCDCD contains the following programs:

� Easy CD Creator
� DirectCD
� UDF Reader

To fully use the capabilities of your CD-RW drive, you need to install both the Easy
CD Creator and DirectCD programs. If you also have a MR (multi-read) CD-ROM or
DVD-ROM drive in your computer, you might need to install the UDF Reader
program to read certain CD-R or CD-RW discs in these drives.

To install the Easy CD Creator/DirectCD software for Windows 98, Windows 95,
Windows 2000 or Windows NT 4.0:

1. Insert the Easy CD Creator/DirectCD CD into your CD-RW drive.
2. If the Adaptec Easy CD Creator Installation window opens, follow the onscreen

instructions. If not, continue to the next step.
3. Click Start --> Settings --> Control Panel.
4. Double-click Add/Remove Programs.
5. Follow the on-screen instructions to complete the installation. Repeat as

necessary to install each of the Easy CD Creator, DirectCD, and UDF Reader
components.

6. Restart your operating system.
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Using CD-R and CD-RW discs

The CD-RW drive can write to both CD-R and CD-RW discs. CD-R discs cannot be
erased, but can be used with standard CD-ROM drives and CD players. You can use
CD-R discs to record audio tracks, store data, archive files, and copy files from
another CD.

CD-RW discs can be erased and rewritten, but can be used only with newer MR
(multi-read) and CD-RW compatible CD-ROM and DVD-ROM drives. You can use
CD-RW discs to back up, store, and update files, or to copy files from another CD.
Note:  CD-R discs are playable on audio CD players. CD-RW discs are not playable

on most audio CD players.

Using the drive

This section will give you information on how to handle and care for CDs and your
CD-RW drive, how to load CDs into your CD-RW drive, and how to get started using
the Easy CD Creator and DirectCD programs.

Handling and caring for a CD

CDs are high-density media that must be handled with care and kept clean to insure
that they remain readable. These precautions will help to prolong the life of your
CDs.

Attention:  Wiping a CD using a circular motion might cause loss of data.

� Handle the CD by the edges or by the center hole. Do not touch the surface of
the CD.

� To remove dust or fingerprints, wipe the CD from the center to the edge with a
soft, lint-free cloth.
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� Do not write on the surface.

� Do not place the CD in direct sunlight.

� Do not use commercial cleaners to clean the CD.

� Do not bend the CD.

Caring for the CD-RW drive

To protect your CD-RW drive during operation, observe the following precautions.

� Remove any CD in the drive before moving the drive.

� Do not insert foreign objects into the drive.

� Do not stack objects on the drive.

� Do not remove the drive cover or attempt to service the drive.

� Do not operate the drive under any of the following conditions:

– High temperature, high humidity, or direct sunlight
– Excessive vibration, sudden shock, or inclined surface
– Excessive dust

Loading a CD

To load a CD into a horizontally mounted CD-RW drive, follow these steps.

1. Press the Eject/Load button. The tray slides out of the drive.

2. Insert the CD into the loading tray with the label facing up.

3. Close the loading tray by pressing the Eject/Load button, or by gently pushing the
tray in.

Attention:  Do not force the tray to open; do not insert foreign objects into the
CD tray. If your tray does not open when you press the Eject/Load button, see
“Manually ejecting a CD” on page 1-13 for information on manual ejection.
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To load a CD into a vertically mounted CD-RW drive, follow these steps.

1. Press the Eject/Load button.

2. Look at the illustrations and compare them to your loading tray.

� If your loading tray looks like the left illustration, insert the CD carefully so
that the edges of the CD are underneath the tabs on the loading tray. These
plastic tabs cover the edges of the CD and hold it in place. The tabs are
attached to the tray itself and cannot be moved.

� If your loading tray looks like the right illustration, insert the CD into the
tray, and gently push the movable tab forward to hold the CD in place.

3. Close the loading tray by pressing the Eject/Load button, or by gently pushing the
tray in.
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Manually ejecting a CD

If you press the Eject/Load button and the tray does not slide out, turn off the
computer and straighten a large paper clip to form a tool, as shown in the illustration.
The straightened end must extend at least 45 mm (1.8 in.). Insert the extended end
into the manual-eject hole on the front of the drive (see “Front view of the drive” on
page 1-4). Push the paper clip into the hole until the tray opens. Gently pull out the
tray until you can remove the CD.

45 mm

1.8 in

Using the Easy CD Creator/DirectCD programs

To use the Easy CD Creator/DirectCD software, insert a blank or partially-recorded
CD-R or CD-RW disc (this option kit includes a blank CD-R disc and a blank CD-RW
disc) into your CD-RW drive. The Easy CD Creator menu window opens
automatically.

To open DirectCD:

1. Click Start --> Programs --> Adaptec DirectCD.
2. Click DirectCD Wizard .

 Formatting CDs

You must format a blank CD-RW disc using DirectCD before you can copy files to
the disc.

To format a CD-RW disc5 with the DirectCD program:

1. Insert a blank disc (included) in the drive. The DirectCD Wizard Welcome
window opens.

2. Click Next twice. The Format Disc window opens.

Attention:  Formatting completes in about 30 minutes. The DirectCD program
configures the disc to receive data, verifies the integrity of the disc surface, and
writes DirectCD file system structures to the disc. You can do other tasks on your
computer while the disc is being formatted.

3. Click Next to continue. The Name Your Disc window opens.

5 Some CDs, such as multisession CDs, do not require formatting. For more information, see the
Adaptec software online user’s guide.
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4. Type the title of your disc in the Name Your Disc window. The disc name can
be up to 11 characters.

5. If you plan to use data compression software with this disc, click to check the
box next to the message Enable compression on this disc.

6. Click Finish in order to start disc formatting. When the disc is finished
formatting, the Disc Ready window opens.

7. Click OK  in the Disc Ready window.

You can now write information to the disc.
Note:  If you have a problem formatting a CD-RW disc, go to Appendix B, “Problem

solving” on page 2-5.

If you want to read a DirectCD-formatted disc in another computer that has a MR
(multi-read) drive, you might have to install the UDF Reader program on the other
computer.

Creating data CDs

To create data CDs:

1. Click Start --> Programs --> Adaptec Easy CD Creator --> Create CD.

2. When the Easy CD Creator window opens, click Data.

3. Click Data CD.
Note:  If you click DirectCD instead of Data CD the Easy CD Creator program

will close and the DirectCD Wizard will open instead.

4. The window that opens is similar to the Windows Explorer. In the top section,
click to select the files or directories you want to add to the CD.

5. Click the Add button at the top of the window to add the files to your CD.

For information on advanced features such as making a multisession CD, or creating a
CD using the File menu instead of the Easy CD Creator Wizard, see the Adaptec
software online user’s guide.

Creating audio CDs

To create audio CDs:

1. Click Start --> Programs --> Adaptec Easy CD Creator --> Create CD.
2. When the Easy CD Creator window opens, click Audio.
3. Click Audio CD.
4. The window that opens is similar to the Windows Explorer. In the top section,

click to select the audio files or audio tracks you want to add to the CD.
5. Click the Add button at the top of the window to add the files to your CD.

For information on advanced features such as making a multisession CD, or creating a
CD using the File menu instead of the Easy CD Creator Wizard, see the Adaptec
software online user’s guide.
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Making a jewel case insert

You can use Easy CD Creator to create a jewel case insert or CD label. When you
create a data or audio CD, the Easy CD Creator program creates a jewel case insert
using the information in your CD layout, such as CD title, artist name, and song list.

To print a jewel case insert or CD label:

1. Click Start --> Programs --> Adaptec Easy CD Creator --> Create CD.
2. Click Jewel Case Creator.
3. On the left, click to select the front cover, inside front cover, back cover, or CD

label.
4. Make any changes in the main editing window. You can change the background

theme by clicking the Format menu and selecting Change Themes.
5. When you are finished making changes, click the File menu and select Print ;

then click OK .

For more information on changing the information in the Jewel Case Layout window,
see the Adaptec software online user’s guide.

Backing up a CD

Attention:  The CD Copier program copies files from one CD to another CD. To
copy a commercial CD, you must either own the copyright or obtain permission
from the copyright owner. If you do not own the copyright or do not have
permission to copy from the copyright owner, you might be violating copyright
law and might be subject to payment of damages or other remedies. For more
information on copyright law, consult your legal advisor.

To back up (copy) a CD using your CD-RW drive:

1. Click Start --> Programs --> Adaptec Easy CD Creator --> Features.

2. Click CD Copier.

The CD Copier window will open.

3. Click the Source and Destination tab if it is not on top.

4. In the Copy From section, select the source drive from the scrolldown box.
Note:  This is the drive containing the CD you want to copy.

5. In the Record To section, select the CD-RW drive from the scrolldown box. Be
sure that there is a blank CD-R or CD-RW disc in the CD-RW drive.

6. On the Advanced tab, you can choose to test the CD for the best possible
recording speed. You can also change the number of copies made, or choose to
have the CD copied to your hard disk before copying it to the blank CD. These
selections will increase the time it takes to copy the CD.

7. When you are finished choosing the settings, place the CD you are going to copy
into the source drive.

8. Click Copy to start copying your CD.
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Installation and usage guide (Translate)

This part of the manual consists of an introduction, installation instructions, and
instructions for using and maintaining the CD-RW drive.

 Introduction

This section will give you a description of this option and the software which comes
with it, as well as some information you will need before you install the option.

 Product description

The IBM can write and read CD-RW (CD-ReWritable) and CD-R (CD-Recordable)
discs, and can read mass-produced stamped CDs. As a result, CDs created by this
drive are compatible with MR (Multi-Read) CD-ROM and DVD-ROM drives that can
read CD-RW discs and other media types, and with older non-MR CD-ROM drives
that can read only CD-R and CD-ROM discs.

The drive writes to CD-RW and CD-R discs at different speeds. The drive can write
to a CD-RW disc at up to four times the standard CD-ROM speed, recording data at
up to 1200 KB1 per second. At this rate, the drive can record approximately 650 MB2

of information on a CD-RW disc in about 18 minutes. The drive can write to a CD-R
disc at up to eight times the standard CD-ROM speed, recording data at up to 2400
KB per second. At this rate, the drive can record approximately 650 MB of
information on a CD-R disc in about nine minutes. The drive can also read data at up
to 32 times the standard CD-ROM speed, or 9600 KB per second.
Note:  To use the drive’s CD-recording function, you must install the Easy CD

Creator/DirectCD software (included) for Microsoft Windows 98, Windows
95, or Windows NT 4.0. For more information on the Easy CD
Creator/DirectCD software, see “Software description” on page 1-2.

The IBM can be installed only in a computer that uses the integrated drive electronics
(IDE) or the enhanced IDE architecture.

In addition to this book, the option kit includes:

� CD-RW drive
� Two audio cables
� Four mounting screws (M3 x 5 mm, slotted)
� IDE cable
� Two faceplates8 for use with certain systems

6 KB equals approximately 1024 bytes when referring to data transfer speeds.
7 MB equals approximately 1 000 000 bytes when referring to storage capacity.
8 If you purchased the black option kit, you will receive one black faceplate.
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� Blank CD-RW disc
� Blank CD-R disc
� Adaptec Easy CD Creator/DirectCDdisc
� IBM Option Diskette
� Laser Safety Guide for CD-ROMs
� Electrical safety booklet

Contact your place of purchase if an item is missing or damaged. Be sure to retain
your proof of purchase. It might be required to receive warranty service. See
Appendix D, “Help and service information” on page 2-20 for technical support
information.

 Software description

The Adaptec Easy CD Creator/DirectCD CDcontains programs that work with
Windows 98, Windows 95, Windows 2000, and Windows NT Workstation 4.0. You
can use the programs with your CD-RW drive to create audio and data CDs, to copy
CDs, and to make jewel case inserts or CD labels. This manual will give you basic
instructions on using the software so that you can get started creating CDs. Additional
information about the software and how to use it can be found in the online user’s
guide on the software disc.

The IBM Option Diskettecontains device drivers for Windows 98, Windows 95,
Windows NT 4.0, Windows 3.x, OS/2, and DOS that enable you to access the drive as
a CD-ROM drive in DOS mode. The diskette also includes an audio CD-player
program for DOS and a diagnostic program.
Note:  The software included in this option kit does not enable the drive’s

CD-recording capabilities with DOS, Windows 3.x, or OS/2 operating systems.

Before you begin

Read the following information before you start your installation.

You must complete the following steps to install the drive:

1. Determine which IDE port to use and the corresponding configuration setting.
2. Place or change the configuration jumper on the drive (and possibly make

changes to the configuration jumpers of other devices).
3. Install the drive in a drive bay.
4. Configure the system.
5. Install a device driver.

If you do not understand these procedures or are unsure about your ability to perform
all the procedures described, have a qualified computer technician install the CD-RW
drive for you.

 System requirements
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Before you begin installing the drive, be sure your computer meets the following
system requirements.

� Minimum microprocessor: IntelPentium processor (or the equivalent)
� Minimum RAM: 16 MB4

� 3.5-inch diskette drive
� Available IDE connection
� Available internal power connection
� Available drive bay
� One of the following operating systems:

– DOS 6.0 or later
– Microsoft Windows NT Workstation 4.0
– Microsoft Windows 95 or Windows 98
– Microsoft Windows 2000
– OS/2 3.0 or later

You might need a flathead or phillips screwdriver to complete the installation. You
might also need to refer to the documentation that comes with your computer. Be sure
to have the documentation available.

 Handling instructions

To protect your CD-RW drive during installation, observe the following precautions:

� Handle the drive with care. Dropping or jarring the drive can damage the
components inside the drive housing.

� Keep the CD-RW drive in its antistatic bag until you are ready to install the drive
in your computer. Limit your movement. Movement can cause static electricity
buildup.

� Do not force the insertion of power or signal cables. Doing so might damage the
connector or the drive.

Front view of the drive

Refer to the following illustration to identify parts that might be referred to in the
installation instructions.

9 When referring to memory storage capacity, MB means approximately 1 000 000 bytes; total
user-accessible capacity may vary depending on operating environment.
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.1/ Headphone jack
This jack provides audio output to the headphones.

.2/ Volume control
This dial controls the headphone volume.

.3/ CD tray
This tray is where you load and unload a CD.

.4/ Busy indicator
This light comes on when the drive reads from, writes to, or plays a CD.

.5/ Manual-eject hole
This hole provides access to the eject mechanism to remove a CD from the drive.

.6/ Eject/Load button
This button opens and closes the CD tray when you push it.

Back view of the drive

Refer to the following illustration to identify parts that might be referred to in the
installation instructions.

.1/ Reserved
 

.2/ Audio-out connector
This port connects the CD-RW drive to a sound adapter.

.3/ Configuration pins
These pins are used to set the drive configuration.

.4/ IDE connector
This port connects the CD-RW drive to the IDE cable.

.5/ DC-power connector
This port connects the CD-RW drive to the computer power supply cord.

Installing the drive

Follow these steps to install the CD-RW drive into your computer.
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Step 1. Opening the computer

1. Turn off the computer and all attached devices.
2. Unplug the power cords for the computer and all attached devices.
3. Remove the cover from the computer.

Step 2. Unpacking the drive

1. Before opening the antistatic bag that the drive is packed in, touch it to an
unpainted metal surface for at least two seconds. This drains the static electricity
from the package and your body.

2. Remove the drive from the bag.

If you must put the drive down, place the antistatic bag on a flat padded surface,
such as a magazine, and place the drive on the antistatic bag.

Step 3. Selecting an IDE port

Newer computers typically have two IDE ports, each of which can support two
devices. Typically, the IDE port connected to your hard disk drive is the primary IDE
port. The other IDE port is the secondary port. The IDE port and the cable position
that you select determine which configuration jumper setting you use for the drive.

� If you have two IDE ports, connect the CD-RW drive to the secondary IDE port
on your system board or IDE adapter. If the CD-RW drive is the only device on
the secondary IDE port, use the master configuration setting. If the CD-RW drive
is the second device on the secondary port, use the subordinate (or slave)
configuration setting.

� If you must attach the CD-RW drive to the primary IDE port (the same port as a
hard disk drive or other fast device), use the subordinate setting for the CD-RW
drive and the master setting for the faster device. In some instances, you might
need to change the hard disk drive configuration setting to
master-with-subordinate-present when attaching a subordinate device on the same
cable. For further information on setting configuration jumpers on other devices,
refer to the documentation that comes with your computer or with the device in
question.

� Some non-IBM computers support the cable-select setting, where the position of
the device on the cable determines whether a device is master or subordinate.
See the documentation that comes with your computer to determine if your
computer supports this setting.
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Step 4. Setting the configuration jumper

The illustration shows the master .1/ setting, the subordinate (or slave) .2/ setting,
and the cable-select .3/ setting. Configure the CD-RW drive by placing the jumper
over the set of pins corresponding to the setting you chose in “Step 3. Selecting an
IDE port.”

� If you are configuring the CD-RW drive as master, set the jumper to the master
.1/ device setting. (This is how the drive is set when it is shipped.) If there is a
second device on the IDE port, make sure that device is configured as
subordinate.

� If you are configuring the CD-RW drive as subordinate, set the jumper to the
subordinate .2/ device setting. Make sure that the other device on the IDE port
is configured as master (or master-with-subordinate-present).

� If you are configuring the CD-RW drive as cable-select, set the jumper to the
cable-select .3/ device setting. If there is another device on the IDE port, make
sure that the second device is also configured for cable-select.

Step 5. Mounting the drive in the bay

Attention:  Be sure to use the M3 x 5 mm mounting screws in the option
package. Using screws that are too long might damage the drive.

You can mount the CD-RW drive horizontally or vertically in the computer. If you
mount the drive vertically, you must secure any CDs you place into the drive before
the drive tray is closed, or the CD-RW drive will not be able to read the CD properly.
For further instructions on securing your CDs in a vertically mounted drive, go to page
1-12.

1. Slide the drive into the bay. Your computer might have specific required
procedures for installing storage devices. Refer to the documentation that comes
with your computer for further instructions.

2. Align the drive-bay screw holes with the threaded holes in the drive housing or
mounting bracket; then thread the screws in loosely to check their positions.
Usually two screws are used on each side.

3. Check to make sure the alignment is correct; then tighten the screws to secure the
drive. Do not overtighten.
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Step 6. Attaching the cables to the drive

Connect the cables to the CD-RW drive as follows.

1. If you want to connect the CD-RW drive to your sound adapter or to the sound
function on your system board, locate the included audio cables and determine
which cable best fits the CD audio-in port on your sound adapter. Connect one
end of the selected audio cable to the CD-RW drive audio-out connector .1/, and
the other end of the cable to your sound adapter CD audio-in port. Save the other
cable in case you use a different sound adapter in the future.

2. Attach a 40-pin IDE-cable connector .2/ to the IDE connector on the drive.
Align the cable so that the color-coded edge is closest to the power cable
connector .3/. Use the IDE cable provided with this option if there is no cable
attached to the IDE port or if there is only one device connector on the IDE
cable. If you use the included IDE cable, attach one end of the cable to your
system board IDE port or to your IDE adapter, and the other end of the IDE cable
to the CD-RW drive.

3. Locate one of the available power cords attached to your computer power source.
Attach the four-pin power cable .3/ to the CD-RW drive dc power connector.

Step 7. Completing the hardware installation

1. Be sure that the drive is securely mounted and the connectors are firmly attached.
2. Be sure that the cables do not interfere with the computer cover and do not block

the power-supply fan blades or air-flow paths.
3. Reinstall the computer cover.
4. Reconnect all devices and check any devices that might have become

disconnected, such as the keyboard, mouse, and monitor.
5. Plug all power cords into electrical outlets.
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Step 8. Attaching the faceplates

This option package includes two faceplates that conform to the curved design of
certain computers. If your computer has a curved design, you can attach one of the
included faceplates so that the front of the CD-RW drive matches the exterior cabinet.
Choose the faceplate that best fits your computer, and attach it after you have mounted
the CD-RW drive in the appropriate bay.
Note:  Depending on the exterior design of your computer, you may need to attach

the faceplate before placing the cover back on your computer.

Step 9. Updating your computer configuration

After you have completed the hardware installation, restart your computer. Usually,
the configuration-setup information screen is displayed. If this screen is not displayed,
check your computer documentation for information about accessing the configuration
or setup utility program.

To see the configuration information for most IBM computers, press F1 during startup.
When you have finished reviewing the information, save the changes and exit.

Note:  Some older computers with one IDE port might not display the CD-RW
drive information when you review the configuration-setup information. You still
can use the CD-RW drive in this situation if you have properly completed the
installation.

Step 10. Installing the (optional) DOS device driver

Note:  This device driver is not necessary to use the CD-RW drive with most
operating systems. It is only necessary if you plan to use the CD-RW drive as a
CD-ROM drive with DOS, or you need to access the CD-RW drive using a DOS
prompt. Be sure to see the READ.ME file on the Option Diskette for the latest
information about the software on the Option Diskette.

The IBM Option Diskettecontains device drivers that allow you to access the CD-RW
drive from a DOS prompt.

To install the IBM Option Diskette device drivers for Windows 98, Windows 95,
Windows 3.x, OS/2 or DOS:

1. Insert the IBM Option Diskette into the diskette drive.
2. Type A:CDSETUP in a command line and press Enter.

 3. Click Setup.
4. Follow the on-screen instructions to install the software.
5. Click Exit  after software installation completes.
6. Restart your computer so the new settings take effect.
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Windows NT 4.0 will automatically detect the presence of the drive. No additional
steps are required to activate the device drivers.

For optional information about configuring the IBM Option Diskette device drivers for
Windows 3.x, DOS, OS/2, Windows 98, and Windows 95, go to Appendix C,
“Customizing device driver configuration settings” on page 2-13.

Step 11. Installing the Easy CD Creator/DirectCD software

Note:  Be sure to see the README file on the Adaptec Easy CD
Creator/DirectCD CD for the latest information about the Easy CD
Creator/DirectCD software.

The Easy CD Creator/DirectCD CDcontains the following programs:

� Easy CD Creator
� DirectCD
� UDF Reader

To fully use the capabilities of your CD-RW drive, you need to install both the Easy
CD Creator and DirectCD programs. If you also have a MR (multi-read) CD-ROM or
DVD-ROM drive in your computer, you might need to install the UDF Reader
program to read certain CD-R or CD-RW discs in these drives.

To install the Easy CD Creator/DirectCD software for Windows 98, Windows 95,
Windows 2000 or Windows NT 4.0:

1. Insert the Easy CD Creator/DirectCD CDinto your CD-RW drive.
2. If the Adaptec Easy CD Creator Installation window opens, follow the onscreen

instructions. If not, continue to the next step.
3. Click Start --> Settings --> Control Panel.
4. Double-click Add/Remove Programs.
5. Follow the on-screen instructions to complete the installation. Repeat as

necessary to install each of the Easy CD Creator, DirectCD, and UDF Reader
components.

6. Restart your operating system.

Using CD-R and CD-RW discs

The CD-RW drive can write to both CD-R and CD-RW discs. CD-R discs cannot be
erased, but can be used with standard CD-ROM drives and CD players. You can use
CD-R discs to record audio tracks, store data, archive files, and copy files from
another CD.

CD-RW discs can be erased and rewritten, but can be used only with newer MR
(multi-read) and CD-RW compatible CD-ROM and DVD-ROM drives. You can use
CD-RW discs to back up, store, and update files, or to copy files from another CD.
Note:  CD-R discs are playable on audio CD players. CD-RW discs are not playable

on most audio CD players.

1-24  IBM 4X/8X/32X CD-ReWritable Internal IDE Option Kit



Using the drive

This section will give you information on how to handle and care for CDs and your
CD-RW drive, how to load CDs into your CD-RW drive, and how to get started using
the Easy CD Creator and DirectCD programs.

Handling and caring for a CD

CDs are high-density media that must be handled with care and kept clean to insure
that they remain readable. These precautions will help to prolong the life of your
CDs.

Attention:  Wiping a CD using a circular motion might cause loss of data.

� Handle the CD by the edges or by the center hole. Do not touch the surface of
the CD.

� To remove dust or fingerprints, wipe the CD from the center to the edge with a
soft, lint-free cloth.

� Do not write on the surface.

� Do not place the CD in direct sunlight.

� Do not use commercial cleaners to clean the CD.

� Do not bend the CD.
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Caring for the CD-RW drive

To protect your CD-RW drive during operation, observe the following precautions.

� Remove any CD in the drive before moving the drive.

� Do not insert foreign objects into the drive.

� Do not stack objects on the drive.

� Do not remove the drive cover or attempt to service the drive.

� Do not operate the drive under any of the following conditions:

– High temperature, high humidity, or direct sunlight
– Excessive vibration, sudden shock, or inclined surface
– Excessive dust

Loading a CD

To load a CD into a horizontally mounted CD-RW drive, follow these steps.

1. Press the Eject/Load button. The tray slides out of the drive.

2. Insert the CD into the loading tray with the label facing up.

3. Close the loading tray by pressing the Eject/Load button, or by gently pushing the
tray in.

Attention:  Do not force the tray to open; do not insert foreign objects into the
CD tray. If your tray does not open when you press the Eject/Load button, see
“Manually ejecting a CD” on page 1-13 for information on manual ejection.
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To load a CD into a vertically mounted CD-RW drive, follow these steps.

1. Press the Eject/Load button.

2. Look at the illustrations and compare them to your loading tray.

� If your loading tray looks like the left illustration, insert the CD carefully so
that the edges of the CD are underneath the tabs on the loading tray. These
plastic tabs cover the edges of the CD and hold it in place. The tabs are
attached to the tray itself and cannot be moved.

� If your loading tray looks like the right illustration, insert the CD into the
tray, and gently push the movable tab forward to hold the CD in place.

3. Close the loading tray by pressing the Eject/Load button, or by gently pushing the
tray in.
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Manually ejecting a CD

If you press the Eject/Load button and the tray does not slide out, turn off the
computer and straighten a large paper clip to form a tool, as shown in the illustration.
The straightened end must extend at least 45 mm (1.8 in.). Insert the extended end
into the manual-eject hole on the front of the drive (see “Front view of the drive” on
page 1-4). Push the paper clip into the hole until the tray opens. Gently pull out the
tray until you can remove the CD.

45 mm

1.8 in

Using the Easy CD Creator/DirectCD programs

To use the Easy CD Creator/DirectCD software, insert a blank or partially-recorded
CD-R or CD-RW disc (this option kit includes a blank CD-R disc and a blank CD-RW
disc) into your CD-RW drive. The Easy CD Creator menu window opens
automatically.
To open DirectCD:

1. Click Start --> Programs --> Adaptec DirectCD.
2. Click DirectCD Wizard .

 Formatting CDs

You must format a blank CD-RW disc using DirectCD before you can copy files to
the disc.

To format a CD-RW disc5 with the DirectCD program:

1. Insert a blank disc (included) in the drive. The DirectCD Wizard Welcome
window opens.

2. Click Next twice. The Format Disc window opens.

Attention:  Formatting completes in about 30 minutes. The DirectCD program
configures the disc to receive data, verifies the integrity of the disc surface, and
writes DirectCD file system structures to the disc. You can do other tasks on your
computer while the disc is being formatted.

3. Click Next to continue. The Name Your Disc window opens.

10 Some CDs, such as multisession CDs, do not require formatting. For more information, see the
Adaptec software online user’s guide.
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4. Type the title of your disc in the Name Your Disc window. The disc name can
be up to 11 characters.

5. If you plan to use data compression software with this disc, click to check the
box next to the message Enable compression on this disc.

6. Click Finish in order to start disc formatting. When the disc is finished
formatting, the Disc Ready window opens.

7. Click OK  in the Disc Ready window.

You can now write information to the disc.
Note:  If you have a problem formatting a CD-RW disc, go to Appendix B, “Problem

solving” on page 2-5.

If you want to read a DirectCD-formatted disc in another computer that has a MR
(multi-read) drive, you might have to install the UDF Reader program on the other
computer.

Creating data CDs

To create data CDs:

1. Click Start --> Programs --> Adaptec Easy CD Creator --> Create CD.

2. When the Easy CD Creator window opens, click Data.

3. Click Data CD.
Note:  If you click DirectCD instead of Data CD the Easy CD Creator program

will close and the DirectCD Wizard will open instead.

4. The window that opens is similar to the Windows Explorer. In the top section,
click to select the files or directories you want to add to the CD.

5. Click the Add button at the top of the window to add the files to your CD.

For information on advanced features such as making a multisession CD, or creating a
CD using the File menu instead of the Easy CD Creator Wizard, see the Adaptec
software online user’s guide.

Creating audio CDs

To create audio CDs:

1. Click Start --> Programs --> Adaptec Easy CD Creator --> Create CD.
2. When the Easy CD Creator window opens, click Audio.
3. Click Audio CD.
4. The window that opens is similar to the Windows Explorer. In the top section,

click to select the audio files or audio tracks you want to add to the CD.
5. Click the Add button at the top of the window to add the files to your CD.

For information on advanced features such as making a multisession CD, or creating a
CD using the File menu instead of the Easy CD Creator Wizard, see the Adaptec
software online user’s guide.
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Making a jewel case insert

You can use Easy CD Creator to create a jewel case insert or CD label. When you
create a data or audio CD, the Easy CD Creator program creates a jewel case insert
using the information in your CD layout, such as CD title, artist name, and song list.

To print a jewel case insert or CD label:

1. Click Start --> Programs --> Adaptec Easy CD Creator --> Create CD.
2. Click Jewel Case Creator.
3. On the left, click to select the front cover, inside front cover, back cover, or CD

label.
4. Make any changes in the main editing window. You can change the background

theme by clicking the Format menu and selecting Change Themes.
5. When you are finished making changes, click the File menu and select Print ;

then click OK .

For more information on changing the information in the Jewel Case Layout window,
see the Adaptec software online user’s guide.

Backing up a CD

Attention:  The CD Copier program copies files from one CD to another CD. To
copy a commercial CD, you must either own the copyright or obtain permission
from the copyright owner. If you do not own the copyright or do not have
permission to copy from the copyright owner, you might be violating copyright
law and might be subject to payment of damages or other remedies. For more
information on copyright law, consult your legal advisor.

To back up (copy) a CD using your CD-RW drive:

1. Click Start --> Programs --> Adaptec Easy CD Creator --> Features.

2. Click CD Copier.

The CD Copier window will open.

3. Click the Source and Destination tab if it is not on top.

4. In the Copy From section, select the source drive from the scrolldown box.
Note:  This is the drive containing the CD you want to copy.

5. In the Record To section, select the CD-RW drive from the scrolldown box. Be
sure that there is a blank CD-R or CD-RW disc in the CD-RW drive.

6. On the Advanced tab, you can choose to test the CD for the best possible
recording speed. You can also change the number of copies made, or choose to
have the CD copied to your hard disk before copying it to the blank CD. These
selections will increase the time it takes to copy the CD.

7. When you are finished choosing the settings, place the CD you are going to copy
into the source drive.

8. Click Copy to start copying your CD.
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 Product registration

Thank you for purchasing OPTIONS by IBM. Please take a few moments to register
your product and provide us with information that will help IBM to better serve you in
the future. Your feedback is valuable to us in developing products and services that
are important to you, as well as in developing better ways to communicate with you.
Register your option on the IBM Web site at:

http://www.ibm.com/pc/register

IBM will send you information and updates on your registered product unless you
indicate on the Web site questionnaire that you do not want to receive further
information.

Product service and warranty information

For technical support, support hours, and warranty terms and conditions, see the
enclosed inserts, or contact your IBM reseller or IBM marketing representative.
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 Part 2: Appendixes

This section includes information on product specifications, how to solve typical
problems, how to customize the DOS device driver for this option, and how to obtain
help and service. It also includes the product warranty and legal notices.

 Appendix A. Product specifications

This appendix includes the the following information:

� Physical specifications
� Power requirements
� Environmental requirements
� Drive write/read speeds
� Drive performance
� Format capabilities

 Physical specifications

The physical specifications11 of the IBM are listed in the following table.

 Power requirements

The following table lists the power specifications by voltage level for the IBM. The
power specifications are measured at the drive power connector and are nominal
values.

Physical Specifications:

Height 42 mm (1.7 in.)

Width 149 mm (5.9 in.)

Length 206 mm (8.1 in.)

Weight 1.1 kg (2.4 lb.)

Power Specifications:

At Voltage +12 V dc +5 V dc

Operational current rating is 1.0 A 1.2 A

11 Product-description data represents IBM's design objectives and is provided for comparative
purposes; actual results might vary, based on a variety of factors. This product data does not
constitute a warranty. Data is subject to change without notice.
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 Environmental requirements

The following table lists the environmental specifications for the CD-RW drive. You
can mount the drive vertically or horizontally.
 

 Write/Read speeds

The following table lists the CD-RW drive write/read speeds for different media.

 Drive-performance specifications

The following table lists the performance specifications of the CD-RW drive.

Environmental Requirements:

Specification Operational Nonoperational

Temperature
(noncondensing)

+5°C to +45°C
(+41°F to +113°F)

−20°C to +60°C
(−4°F to +140°F)

Relative humidity
(noncondensing)

10% to 80% 5% to 90%

Drive Write/Read Speeds:

Function Speed

Read (CD-ROM/CD-R disc) 1X, 2X, 4X, 8X, 16X, 14X-32X (CAV)

Read (CD-RW disc) 8X-20X (CAV)

Write (CD-R disc) 2X, 4X, 8X

Write (CD-RW disc) 2X, 4X

Drive performance:

Feature Specification

Burst data transfer rate 16.7 MB12 per second (ATA PIO Mode 4)
16.7 MB per second (ATA multiword DMA
Mode 2)
33.3 MB per second (UDMA)

Average access time (including latency) 110 ms (14-32X, CAV)

Cache memory (Read/Write) 2 MB

Disc diameter 12 cm (8 cm read-only)

Rotational speed (CD-RW) 4000 rpm

Rotational speed (CD-ROM/CD-R) 7000 rpm

Mean time between failures (MTBF) 120 000 POH (duty 10%)

12 The formatted capacity of 1 MB is approximately 1 000 000 bytes of data.
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The following table summarizes the CD format capabilities of the Easy CD Creator
program. Refer to the Adaptec software online users’s guide for the most recent
information on CD format capabilities.

The CD-RW drive uses the following methods to write files to CDs:

� Disc at Once: The drive writes to the entire disc in a single pass; data cannot be
added at a later time.

� Track at Once: The drive copies one track at a time to the disc.
� Multisession: The drive writes several sessions to a disc; each session has at least

one track.

Listed below are descriptions of different CD formats that appear in the table.

CD-Digital Audio This format records audio CDs that can be played on audio CD
players.

CD Extra This format records audio and data in a multisession format.

CD TEXT This format records audio CDs with the album names and song
titles encoded. CD TEXT information is displayed on CD
TEXT-compatible CD players and CD-ROM drives.

CD-ROM (Mode 1) This format is used for most CD-ROM applications.

CD-ROM XA (Mode 2 Form 1 and Mode 2 Form 2) or CD-ROM Extended
Architecture  This standard was created for playback of

Format Copy
Capability

Create
Capability

CD-DA (Red Book) Yes Yes

CD+G No No

CD TEXT Yes No

CD-ROM (Yellow Book) Yes Yes

CD-ROM XA (Mode 2) Yes Yes

CD-I (Green Book) Yes No

CD-I Bridge No No

Video CD (White Book) Yes No

CD-R (Orange Book P II) Yes Yes

CD-RW (Orange Book P III) Yes Yes

Multisession CD Yes Yes

CD Extra (Blue Book) Yes Yes

Photo CD Yes No

Mixed-Mode CD Yes Yes

Bootable CD Yes Yes

Disc at Once Yes Yes

Track at Once Yes Yes

Session at Once Yes Yes
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multimedia content.

CD-I (Mode 2 Form 1 and Mode 2 Form 2) and CD-I Ready13 This format is used
for home entertainment systems.

CD-I Bridge This format records a combination of Kodak Photo CDs and
Video CDs that can be played on TV set-top players and
personal computers.

Photo CD (single and multisession) This format records Kodak Photo CDs.

Video CD This format records CDs that are playable on TV set-top video
CD players and most DVD systems.

13 The CD-RW drive does not have the necessary audio circuitry and decoding functions for CD-I
playback, but it can read from and write to CDs in this format.
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 Appendix B. Problem solving

Computer problems can be caused by hardware, software, or user error. You might be
able to use the information in this section to solve problems yourself, or gather helpful
information you can pass on to a service technician. You might also need to refer to
your computer, operating-system, or sound-adapter documentation. You can also use
the problem-solving diagnostic program for DOS on the IBM Option Diskette. For
more information on the diagnostic program, see “Diagnostics” on page 2-12.

Review the following list for any problem descriptions that might fit your situation.

 Troubleshooting

Your computer or CD-RW drive does not operate correctly or the busy indicator
light does not come on.

Take the following actions:

1. Check that the CD is loaded with the label side up.

2. Check that all devices are properly connected to the computer and the electrical
outlet.

3. Turn off the computer, unplug the cables from the electrical outlets for your
computer and all attached devices, and remove the computer cover.

4. Check that all power and IDE cables are securely attached. Disconnect the IDE
cable and check for bent or misaligned pins. If you do not find any problems,
reconnect the interface cable. Replace the computer cover, and reattach all cables
and power cords. Turn on the computer, restart the system, and attempt to open
the CD tray by pressing the Eject/Load button. If the tray fails to open and the
busy indicator light does not come on, turn off the computer and try using another
4-pin dc power cable.

5. Check that the color-coded edge on the IDE cable aligns with pin 1 on the IDE
port and is closest to the power cable on the CD-RW drive. See “Step 3.
Selecting an IDE port” on page 1-5.

6. Check that the IDE cable is connected to the proper IDE port connection. See
“Step 3. Selecting an IDE port” on page 1-5 for more information.

7. Check the CD-RW drive and any other device on the IDE cable for the proper
Master/Slave jumper settings. See “Step 3. Selecting an IDE port” on page 1-5
for more information.

8. If the middle connector on the IDE cable is attached to the IDE port on the
system board, remove the connector and reattach the cable. If there is only one
device on the IDE port, attach the connector at one end of the cable to the IDE
port and the connector at the other end to the device, leaving the middle
connector (if there is one) open.
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If there are two devices on the IDE port, attach the connector at one end of the
cable to the IDE port. If there is a hard disk drive, attach it to the connector at
the other end of the cable and attach the CD-RW drive to the middle connector.

You cannot format a CD-RW disc.

Take the following actions:

1. Verify that your computer has the latest level IDE CD-ROM device driver for
your CD-ROM drive. Refer to the documentation for your computer or your
CD-ROM drive to determine which device driver file to look for.

2. Verify that your system has the latest level IDE controller device driver. Refer to
the documentation for your computer or IDE controller to determine which device
driver file to look for.

You cannot create a multisession disc.

Be sure that there is enough space left on the media for another session. Writing a
session requires lead-in and lead-out space (about 15 MB) in addition to the data that
is recorded.

You cannot successfully write to a CD-R or CD-RW disc.

Take the following actions:

1. Verify that the process is not being interrupted by a screen saver, an antivirus
program, an Internet or e-mail program, or other software. Disable the functions
that might interrupt the write operation.

2. Verify that your computer has the minimum processor listed in the system
requirements for this option.

3. Verify that the hard disk drive has been defragmented.

4. Replace the disc if it is damaged or scratched.

5. Disable the Windows Auto Insert Notify function on your CD-ROM and CD-RW
drives.

You cannot eject a CD.

Take the following actions after ensuring that the drive is not in the process of writing
to a disc:

1. Eject the CD through the software.
2. Use the Eject/Load button.
3. Turn off the computer. Wait 45 seconds; then turn on the computer and try using

the Eject/Load button again.
4. If other methods do not work, use the manual-eject hole, using instructions given

in “Manually ejecting a CD” on page 1-13.
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You cannot read from the CD after successfully writing to it.

Take the following actions:

1. If you can read the CD in another CD player or you can see previous sessions,
the directory information might be damaged on the volume, making it unreadable.
Check the Adaptec software online user’s guide for more troubleshooting ideas.

2. You might have a damaged CD-R or CD-RW disc. Try a new CD-R disc or
CD-RW disc, or another brand of disc.

3. If you can read from a CD-RW disc in the CD-RW drive, but not in another MR
drive, be sure that a UDF Reader program is installed on the computer which
contains the other MR drive. For more information on installing the UDF Reader
program, go to “Step 11. Installing the Easy CD Creator/DirectCD software” on
page 1-9.

4. Verify that you are not attempting to write the disc under extreme environmental
conditions such as the following:

� low temperature: 5°C(41°F) or below
� high temperature: 45°C(113°F) or above
� excessive shock:>0.5 G
� excessive vibration:>0.1 G

You cannot access the CD-RW drive, or the drive icon does not display (Windows
98 or 95).

If the CD-RW drive has been properly installed, there will be an icon for the drive in
the My Computer window. If you double-click the My Computer icon and there is no
drive icon present in the displayed window, make sure that the drive has been properly
installed, and that the configuration jumper has been correctly set. For more
information, see “Step 4. Setting the configuration jumper” on page 1-6. Next, restart
your system. If a drive icon is still not found, continue with the following steps.

1. Click Start, and select Settings. The Settings window will open.

2. Click Control Panel.

 3. Click System.

4. Click the Device Manager tab.

5. Double-click View Devices by Type.

a. Click Hard Disk Controllers  on the Device Manager list. Make sure that
there are no conflicts with the controller. Be sure that the device status
indicates that the controller is working properly.

b. Select CD-RW from the Device Manager list. Verify that there is a CD-RW
device and that no conflicts exist. The device status will indicate that the
device is working properly.

 6. Click OK .
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7. Restart the computer.

If the device icon is still not present, check cable connections, device jumper settings,
and resolve any existing conflicts.

You cannot access the CD-RW drive (DOS and Windows 3.x), or the drive icon
(Windows 3.x) does not display.

Your CD-RW drive device driver might not be loaded or cannot be found. Before
checking the CONFIG.SYS and AUTOEXEC.BAT files, make a backup copy of these
files in a preferred directory.

1. At the DOS prompt:

a. Typex:copy CONFIG.SYS CONFIG.IBM, wherex is the directory drive letter
and press Enter.

 b. Typex:copy AUTOEXEC.BAT AUTOEXEC.IBM, wherex is the directory drive
letter and press Enter.

2. Use a text editor such as E or Edit. At the DOS prompt, type E (or your editor
name) CONFIG.SYS and press Enter.

3. Insert the following line at the top of the CONFIG.SYS file to allow for more
than five drive letters, if needed.

 lastdrive=z

4. Check for the following device driver line.

 DEVICEHIGH=C:\IBMIDECD.SYS /D:IBMCD1ðð

If this line is not present, add it.

5. Save the CONFIG.SYS file and exit.

 6. TypeE (or your editor name) AUTOEXEC.BAT and press Enter.

7. Check for the following device driver line.

LH C:\MSCDEX /D:IBMCD1ðð /M:1ð

If this line is not present, add it.

8. If the Windows screen automatically opens when you start your computer, check
that the line

LH C:\MSCDEX /D:IBMCD1ðð /M:1ð

comes before the line that starts Windows (WIN). If not, move the MSCDEX
statement above this line in the file.

9. Save the AUTOEXEC.BAT file and exit.

10. Make sure that the device drivers are on the hard disk and are displayed in the
correct directory, as shown.

  C:\IBMIDECD.SYS
  C:\MSCDEX
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If the device drivers are not present, reinstall them. See the READ.ME file on
the IBM Option Diskettefor more information.

The computer does not recognize the CD-RW drive after the device drivers are
loaded (DOS and Windows 3.X).

Check for incompatibilities among the CD-RW drive device driver and other device
drivers or other hardware in your computer. Create a System Diskette with minimum
CONFIG.SYS and AUTOEXEC.BAT system files.

1. Before creating special CONFIG.SYS and AUTOEXEC.BAT files, make a
backup copy of these files in a preferred directory.

Type x:copy CONFIG.SYS CONFIG.IBM wherex is the directory drive letter
and press Enter.

Type x:copy AUTOEXEC.BAT AUTOEXEC.IBM wherex is the directory drive
letter and press Enter.

2. Create a System Diskette and copy the device drivers onto it using the following
instructions.

a. Insert a blank diskette into the diskette drive.

b. At the DOS prompt, type format a: /s and press Enter. The /s parameter
creates the System Diskette. Follow the instructions on the screen.

c. When the format process completes, copy the C:\IBMIDECD.SYS and
C:\MSCDEX files from the hard disk to the System Diskette.

d. Using a text editor, create a minimum CONFIG.SYS system file on the
System Diskette to support only a CD-RW drive. The following procedure
uses the E text editor to create the CONFIG.SYS file from the A prompt.

1) Type e config.sys and press Enter.

2) In the editor, type lastdrive=z and press Enter.

3) Type device=a:\ibmidecd.sys /d:ibmcd1ðð and press Enter.

4) Save the CONFIG.SYS file and exit from the editor.

e. Using a text editor, create a minimum AUTOEXEC.BAT system file on the
System Diskette to support only a CD-RW drive. The following procedure
uses the E text editor to create the AUTOEXEC.BAT file from the A
prompt.

1) Type e autoexec.bat and press Enter.

2) Typea:\mscdex /d:ibmcd1ðð /m:1ð and press Enter.

3) Save the AUTOEXEC.BAT file and exit the editor.

3. Turn off the computer and check that the System Diskette is in the diskette drive.

4. Restart the computer (the computer will start up from the System Diskette).
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5. Observe the startup messages and check that the device driver IBMIDECD.SYS
loads. When MSCDEX loads, observe the drive letter that the computer assigns
to the CD-RW drive.

6. Load a data CD into the CD tray; then wait until the busy indicator is not lit.

7. Attempt to read from the CD by typing dir x: where x is the CD-RW drive
letter assigned after the MSCDEX message.

� If the computer is able to read the CD, a conflict probably exists between the
device drivers loaded in the CONFIG.SYS or AUTOEXEC.BAT files. You
need to resolve this device conflict. You might have to set some
configuration parameters for your installation; refer to Appendix C,
“Customizing device driver configuration settings” on page 2-13 for more
information.

� If you are unable to access the CD, you might have a hardware problem. If
you are unable to read from the CD or a drive letter is not assigned by
MSCDEX, go to the next step.

8. Turn off the computer, unplug the cables from the electrical outlets for your
computer and all attached devices, and remove the computer cover.

9. Disconnect the IDE and power cable for all IDE devices except the CD-RW
drive.

10. Configure the CD-RW drive as a master and connect it to the last IDE connector
on the primary IDE port.

11. Reinstall the computer cover. Reconnect all devices; then plug the power cords
into electrical outlets.

12. Place the System Diskette in the diskette drive and a data CD in the CD-RW
drive.

13. Restart the computer.

14. Attempt to read from the CD by typing dir C:. (The CD-RW drive is drive C
because it is the only device connected to the IDE port.)

� If the computer is able to read the CD, a conflict probably exists with one of
the devices that was installed on your computer. You need to resolve this
device driver conflict. Check the configuration jumper settings for the other
devices or refer to your device documentation.

� If you are unable to access the CD, you might have a hardware problem. If
the CD-RW drive still does not read from the data CD, the CD-RW drive
might be defective. Go to Appendix D, “Help and service information” on
page 2-20.

The CD cannot be read.

Take the following actions:

1. The CD might be dirty; clean it as described in “Handling and caring for a CD”
on page 1-10.
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2. The CD might be defective; try another CD.

3. The CD is not ISO-9660 or High Sierra Group (HSG) compatible. Check with
your place of purchase.

There is no sound from the CD.

Take the following actions.

1. Check that you are using an audio CD and not a data CD.

2. Adjust the volume control on the drive. See “Front view of the drive” on
page 1-4 to locate the volume control if you have connected headphones to the
front of the drive.

3. Adjust the sound-adapter volume control. See the documentation that comes with
your sound adapter and audio-CD player program.

4. Turn off the computer, unplug the cables from the electrical outlets for your
computer and all attached devices, and remove the computer cover. Check that
the audio-signal cable connects the CD-RW drive to the sound adapter.

Your screen displays an error message.

Take the following actions for two common error messages.

� CDR-103

The CD in the CD-RW drive is not a High Sierra or ISO 9660 format. The
CD-RW drive does not support this format.

� CDR-101

This message displays when you try to access the CD-RW drive before the drive
is ready. The busy indicator lights when you attempt to access the drive after
loading a CD into the CD tray. Wait until the busy indicator stops lighting before
attempting to read the drive.

The connectors on the audio cables provided do not fit the connector on your
sound adapter.

Some sound adapters might require a special cable. See the documentation that comes
with your sound adapter.

You might have to separately purchase an audio cable for the CD-RW drive. The
audio-out connector on the CD-RW drive requires a MPC-2 compliant Molex 70066-G
connector. (To locate the drive audio connector, refer to “Back view of the drive” on
page 1-4.) If you are using an IBM computer or IBM sound adapter, refer to
Appendix D, “Help and service information” on page 2-20 for assistance.

Part 2: Appendixes  2-11



 Diagnostics

The IBM Option Diskettecontains a problem-solving diagnostic program for DOS.
You must successfully load the CD-RW drive device drivers before starting the
diagnostic program.

To start the diagnostic program, insert the IBM Option Diskette, type A:CDDIAG at the
DOS prompt, and press Enter.

 Additional help

The READ.ME file on the IBM Option Diskette includes troubleshooting hints. If you
follow these instructions and still have a problem, go to Appendix D, “Help and
service information” on page 2-20.
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Appendix C. Customizing device driver
configuration settings

Attention:  After you install the IBM Option Diskette, you can use a DOS session
in Windows 3.x, DOS, OS/2, Windows 98, and Windows 95 to access the drive as
a CD-ROM drive.

This section contains optional configuration information for theIBM Option Diskette
device drivers for Windows 3.x, DOS, OS/2 and Windows 98 and 95. Use the online
help during the installation and refer to the READ.ME file on the IBM Option Diskette
for additional information.

Requirements vary, and you might need to customize the configuration that the
CDSETUP program installed on your computer. This section provides information and
describes parameters that you might need to change or add for your installation.

Changing device driver parameters for DOS and Windows 3.x

Most computers will function adequately with the default settings for the
IBMIDECD.SYS device driver file. However, there are some parameters that can be
changed if necessary. This section explains the function of each parameter. Use a text
editor to modify the appropriate line in your CONFIG.SYS file. For the
IBMIDECD.SYS device driver file, the line in CONFIG.SYS is in the following
format:

DEVICE=[drive:][path]IBMIDECD.SYS /D:device name
[/P:xxx,yy] [/A:n] [/U:n]
[/L:xx] [/T:n] [/I:n]

(Do not truncate the actual device driver entry. Place the complete DEVICE= on one
line in the CONFIG.SYS file.)

 [drive:][path]IBMIDECD.SYS

The above parameter specifies the location (drive and directory) and name of the
device driver file.

Use the following options to configure the device driver.

/D:device name
This parameter specifies the device name of the CD-ROM drive. This name
must be identical to the device name specified in the MSCDEX.EXE
parameters, as shown:

 DEVICE=C:\IBMIDECD.SYS /D:IBMCD1ðð

/P:xxx,yy
This parameter specifies the address and interrupt level of the port to which the
IDE CD-ROM drive is connected.
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The device driver automatically checks the industry standard primary IDE port
(address 1F0, interrupt 14) and secondary IDE port (address 170, interrupt 15).
The /P parameter is not needed if your CD-ROM drive is connected to either of
these ports. However, if your computer (or IDE adapter) uses different IDE
port addresses or interrupts, you must use this option. Refer to the instructions
that come with your computer or IDE adapter for more information about the
configuration of your computer or adapter.

xxx is the base address of the IDE port.

1F0 for the primary IDE port (Port 1)
170 for the secondary IDE port (Port 2)

yy is the interrupt (IRQ) level.

14 for the primary IDE port (Port 1)
15 or 10 for the secondary IDE port (Port 2)

When four drives are connected, for example, the syntax in the CONFIG.SYS
file would be:

DEVICE=C:IBMIDECD.SYS /D:IBMCD1ðð /P:1Fð,14

/P:17ð,15 /P:1Eð,12 /P:16ð,1ð

(Do not truncate the actual device driver entry. Place the complete DEVICE=
on one line in the CONFIG.SYS file.)

/A:n
This parameter specifies the audio play mode. For a stereo CD, you can type
/A:0 or /A:1. For a monaural CD (left or right channel only), type /A:1 in order
to play the monaural audio signal from the right and left channels. The default
is n=0.

/U:n
This parameter specifies if your computer initializes with the CD tray unlocked
or locked. /U:0 initializes with the tray unlocked. /U:1 initializes with the tray
locked. The default command is n=0. This command might be used if you
want to secure your CD in the drive.

/L: xx
This parameter specifies the message language where xx designates the
language.

/T:n
This parameter specifies time delays to be built into the IDE read loop. Use
this parameter only in computers that do not support the IOCHRDY signal on
the IDE bus, and in computers that read from the IDE port faster than the

US
GR
FR
SP
IT
JP

English (default, does not need to be specified)
German
French
Spanish
Italian
Japanese

2-14  IBM 4X/8X/32X CD-ReWritable Internal IDE Option Kit



CD-ROM can provide data. This parameter is usually not required in most
computers.

n is a relative timing parameter that depends on processor speed. When the
value of n increases, the drive data-transfer rate decreases. Valid values for n
are 0 through 99. The default for n is 0, and the /T parameter is not required.

/I: n
This parameter enables interrupt sharing. If n=1, interrupt sharing is enabled.
If n=0, interrupt sharing is disabled. The default value is 0. Set this parameter
to enabled when the IDE interrupt must be shared with another device.

Using Microsoft CD-ROM Extensions

Microsoft CD-ROM Extensions (MSCDEX.EXE) is an executable program that works
in conjunction with the device driver (IBMIDECD.SYS) to enable your computer to
read CDs as DOS-formatted disks. MSCDEX is designed for DOS and Windows.

The CDSETUP program automatically adds an MSCDEX statement to your
AUTOEXEC.BAT file. You can modify the default MSCDEX parameters to
customize your installation. This section explains the function of each parameter. A
text editor can be used to modify the MSCDEX statement in your AUTOEXEC.BAT
file.

The following is the syntax of the MSCDEX.EXE entry in AUTOEXEC.BAT where
[drive:][path]MSCDEX.EXE specifies the location (drive and directory) of the
MSCDEX.EXE file.

[drive:] [path]MSCDEX.EXE /D:device name
[/M:n] [/E] [/V] [/L:drive letter]

 [/K][/S]

(Do not truncate the actual device driver entry. Place the complete entry on one line
in the AUTOEXEC.BAT file.)

Use the following options to configure the device driver.

/D:device name
This parameter specifies the name of the CD-ROM drive (eight characters
maximum). This name must be identical to the device name specified in the
device driver in the CONFIG.SYS file. For example:

 C:\MSCDEX.EXE /D:IBMCD1ðð

You might support multiple CD-ROM drives (of different types) by installing
each of their device drivers (naming them different names) and placing a
/D:device name in the MSCDEX line for each drive. For example, if you
wanted to support an IBM IDE CD-ROM drive and an IBM SCSI CD-ROM
drive, your CONFIG.SYS file might have these statements:

 DEVICE=C:\IBMIDECD.SYS /D:IDE_CD

 DEVICE=C:\IBMCDROM.SYS /D:SCSI_CD

and your AUTOEXEC.BAT file could include this statement:

C:\MSCDEX /D:IDE_CD /D:SCSI_CD
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/M: nn
This parameter specifies the number of sector buffers for temporary storage of
the most recent CD data. For example, to specify 12 sector buffers you would
use:

C:\MSCDEX.EXE /D:IBMCD1ðð /M:12

The CDSETUP program sets this value to 10. The default value for MSCDEX
with no /M parameter is 4.

You can improve CD-ROM drive performance when you use larger default
values. However, each buffer uses about 2 KB of memory, and too many
buffer specifications might slow down your computer or interfere with other
programs that have large memory-usage requirements. You might be able to
specify a larger number of buffers to enhance CD-ROM drive performance
without adversely affecting programs that have large memory-usage
requirements if you use expanded memory (see the /E option in this section) or
if you load MSCDEX.EXE into high memory using instructions given in the
documentation that comes with your operating system or with the memory
manager.

/E
This parameter instructs the computer to use expanded memory, if available.
For example:

C:\MSCDEX.EXE /D:IBMCD1ðð /E

Note that you must first load an expanded memory device driver before using
this option. If no expanded-memory device driver is loaded, the following error
message displays:

Expanded Memory not present or not usable.

/V
This parameter instructs the computer to display a summary of RAM allocation
and expanded memory usage at startup time.

/L: drive letter
This parameter specifies the drive letter to be assigned to the first CD-ROM
drive. Do not assign a letter already used by an existing drive or your computer
will not be able to access the CD-ROM drive. For example, you might use:

C:\MSCDEX.EXE /D:IBMCD1ðð /L:F

Normally, the CD-ROM drive is assigned to the next available drive letter after
devices such as diskette drives and hard disk drives. Therefore, you use this
option only if you wish to assign a drive letter beyond the last letter previously
allocated by DOS.

/K
This parameter instructs MSCDEX.EXE to use Kanji (Japanese) file structures,
if present, rather than the default alphanumeric file structures.
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/S
This parameter instructs MSCDEX.EXE to allow networked computers to share
CD-ROM drives.

Conserving DOS conventional memory

If the CD-ROM drive-support software is loaded in DOS conventional memory (below
640 KB RAM), there might be insufficient memory to run some DOS applications.
The CDSETUP program attempts to load the IDE CD-ROM drive device driver and
MSCDEX into upper memory, when possible, to avoid this problem.

For more information on techniques to conserve conventional memory, refer to the
following topics in the documentation that comes with your operating system:

� DOS=UMB, DOS=HIGH,UMB (CONFIG.SYS entry)

This command enables the use of upper memory and loads DOS, MSCDEX, and
the IDE CD-ROM device driver in upper memory.

� HIMEM.SYS (CONFIG.SYS entry)

This is a device driver that manages extended memory (RAM memory above 1
MB). Windows automatically loads this device driver.

� EMM386.EXE (CONFIG.SYS entry)

This is a device driver that allows the extended memory made available by
HIMEM.SYS to be used as expanded memory. The MSCDEX /E parameter
might be used in conjunction with this device driver to move the cache allocated
by MSCDEX into this memory, thus freeing some conventional memory.

� MEM /C /P (use from DOS prompt)

This is a useful DOS utility that will display the current memory allocation in
your computer to help you understand where device drivers and programs are
located. To display the MEM parameters available, at the DOS prompt type
mem/?

Enhancing performance in DOS and Windows

The following two procedures can enhance CD-ROM drive performance.

1. Allocate more MSCDEX cache (see /M parameter for MSCDEX).

2. Allow SMARTDRV to cache CD-ROM accesses.

The CDSETUP program disables the cache CD-ROM data function. Multisession
CDs are not compatible with the SMARTDRV caching method. If you do not
plan to use PhotoCD or multiple-session CDs, you can enable caching by
removing the /U parameter from the SMARTDRV line in your AUTOEXEC.BAT
or CONFIG.SYS file. This might improve the performance of some CD-ROM
applications. You must have SMARTDRV 5.0 or later to cache CD-ROM data.
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Updating the device driver for a DOS network server

If you are using the CD-RW drive in a DOS Network server you need to make the
following changes:

1. Add the /S parameter to the MSCDEX line in the AUTOEXEC.BAT file.

2. Verify that the MSCDEX line is located after the line that loads the network
services (NET START for IBM PC LAN program).

3. Do one of the following, depending on your operating system:

� If you are using DOS 3.3, be sure you have PC Local Area Network (LAN)
Program Corrective Service Diskettelevel IP00755 or later installed.

� If you are using DOS 4.0, be sure you have DOS Corrective Service Diskette
level UR 29015 or later installed. (The computer cannot be configured as an
Extended Services Domain Controller for the IBM PC LAN Program.)

Contact your IBM reseller for more information about the PC LAN Program
Corrective Service Disketteor the DOS Corrective Service Diskette.

Changing the device driver for OS/2

You might need to customize the setup that the DDINSTAL file has installed on your
computer in order to meet your requirements. This section provides information and
describes parameters that you might need to change or add for your installation.

OS/2 uses the OS2CDROM.DMD device driver

 DEVICE=OS2CDROM.DMD [Options]

to control all CD-ROM devices. The following parameters are available:

/V Instructs the computer to display the installation details.

/Q Suppresses messages during initialization.

Changing the OS/2 device driver filter

OS/2 uses the device driver filter IBMIDECD.FLT for ATAPI (IDE) CD-ROM drives.

 BASEDEV=IBMIDECD.FLT [Options]

The following parameter is available:

/V Instructs the computer to display installation details.

Changing the OS/2 installable file system driver

The file system device driver for OS/2 is CDFS.IFS. The following parameters are
available:

/C:n Indicates how many 64 KB RAM segments will be used for the sector cache.
The default is (/C:2) two 64 KB RAM segments.
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/M: n Indicates the maximum number of file sectors to be read at a time. The
default is eight sectors (/M:8).

/K Uses Kanji supplementary volume descriptor.

/Q Suppresses messages during initialization.

Changing the OS/2 IDE adapter device driver

The following IDE device driver is available:

BASEDEV=IBM1S5ð6.ADD (for ISA computers)

This device driver controls IDE hard disk drives and IDE CD-ROM drives. At the
OS/2 command prompt, type help IBM1S5ð6 to see the optional parameters that are
available for ISA computers.

Special parameters are required if your computer has an IDE controller that does not
use a standard interrupt. Check the /A and /IRQ parameters in the OS/2 help utility.

Changing the Windows 98 and Windows 95 device drivers

Windows 98 and Windows 95 have two device driver configuration parameters: Auto
Insert Notify and DMA.

The Auto Insert Notify parameter enables the computer to start audio CD software as
soon as a CD is inserted into the CD-RW drive.

The DMA parameter improves computer performance by having the computer DMA
controller handle moving data from the CD to memory, freeing the computer
microprocessor to perform more important tasks. For example, activating DMA might
make movies and games run more smoothly because the microprocessor will be
allocating more processing time to video.

Changing the Auto Insert Notify and DMA parameters

To change these parameter settings from the Windows 98 or Windows 95 desktop:

1. Click Start --> Settings --> Control Panel.
 2. Double-clickSystem.
3. Select Device Manager.

 4. Double-clickCD-ROM .
 5. Click Properties.
 6. SelectSettings.
7. Click Auto Insert Notification  or DMA .

 8. Click OK .
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Appendix D. Help and service information

See Appendix B, “Problem solving” on page 2-5 before requesting help or service.

This section contains information on how to obtain online and telephone technical
support.

Online technical support

Online technical support is available during the life of your product. Online assistance
can be obtained through the Personal Computing Support Web site or the IBM
Automated Fax System.

During the warranty period, assistance for replacement or exchange of defective
components is available. In addition, if your IBM option is installed in an IBM
computer, you might be entitled to service at your location. Your technical support
representative can help you determine the best alternative.

Telephone technical support

Marketing, installation, and configuration support through the HelpCenter will be
withdrawn or made available for a fee, at IBM’s discretion, 90 days after the option
has been withdrawn from marketing. Additional support offerings, including
step-by-step installation assistance, are available for a nominal fee.

To assist the technical support representative, have available as much of the following
information as possible:

 1. Option name
 2. Option number
3. Proof of purchase
4. Computer manufacturer, model, serial number (if IBM), and manual
5. Exact wording of the error message (if any)
6. Description of the problem
7. Hardware and software configuration information for your system

If possible, be at your computer. Your technical support representative might want to
walk you through the problem during the call.

Online technical support

IBM Personal Computing Support Web Site http://www.ibm.com/pc/support

IBM Automated Fax System 1-800-426-3395 (in U.S. and Canada)
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For the support telephone number and support hours by country, refer to the following
table or to the enclosed technical support insert. If the number is not provided, contact
your IBM reseller or IBM marketing representative. Response time may vary
depending on the number and nature of the calls received.

Support 24 hours a day, 7 days a week

Canada 1-800-565-3344

U.S.A./Puerto Rico 1-800-772-2227
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Appendix E. Product warranty and notices
This section includes product warranty information and legal notices.

 Warranty statements

The warranty statements consist of two parts: Part 1 and Part 2. Part 1 varies by country. Part 2
is the same for both statements. Be sure to read both the Part 1 that applies to your country and
Part 2.

� United States, Puerto Rico, and Canada (Z125-4753-05 11/97)
(Part 1 - General Terms on page 2-22)

� Worldwide except Canada, Puerto Rico, Turkey, and United States (Z125-5697-01
11/97)
(Part 1 - General Terms on page 2-25)

� Worldwide Country-Unique Terms
(Part 2 - Country-Unique Terms on page 2-27)

IBM Statement of Limited Warranty for United States, Puerto
Rico, and Canada (Part 1 - General Terms)

  

This Statement of Limited Warranty includes Part 1 - General Terms and Part 2 - Country-unique
Terms. The terms of Part 2 may replace or modify those of Part 1. The warranties provided
by IBM in this Statement of Limited Warranty apply only to Machines you purchase for your use,
and not for resale, from IBM or your reseller. The term “Machine” means an IBM machine, its
features, conversions, upgrades, elements, or accessories, or any combination of them. The term
“Machine” does not include any software programs, whether pre-loaded with the Machine,
installed subsequently or otherwise. Unless IBM specifies otherwise, the following warranties
apply only in the country where you acquire the Machine. Nothing in this Statement of Warranty
affects any statutory rights of consumers that cannot be waived or limited by contract. If you have
any questions, contact IBM or your reseller.

Machine - IBM 4X/8X/32X CD-ReWritable Internal IDE Option Kit

Warranty Period* - One Year

*Contact your place of purchase for warranty service information. Some IBM Machines are eligible
for On-site warranty service depending on the country where service is performed.

The IBM Warranty for Machines
IBM warrants that each Machine 1) is free from defects in materials and workmanship and 2)
conforms to IBM's Official Published Specifications. The warranty period for a Machine is a
specified, fixed period commencing on its Date of Installation. The date on your sales receipt is
the Date of Installation, unless IBM or your reseller informs you otherwise.

During the warranty period IBM or your reseller, if approved by IBM to provide warranty
service, will provide repair and exchange service for the Machine, without charge, under the type
of service designated for the Machine and will manage and install engineering changes that apply
to the Machine.
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If a Machine does not function as warranted during the warranty period, and IBM or your reseller
are unable to either 1) make it do so or 2) replace it with one that is at least functionally
equivalent, you may return it to your place of purchase and your money will be refunded. The
replacement may not be new, but will be in good working order.

Extent of Warranty
The warranty does not cover the repair or exchange of a Machine resulting from misuse, accident,
modification, unsuitable physical or operating environment, improper maintenance by you, or
failure caused by a product for which IBM is not responsible. The warranty is voided by
removal or alteration of Machine or parts identification labels.

THESE WARRANTIES ARE YOUR EXCLUSIVE WARRANTIES AND
REPLACE ALL OTHER WARRANTIES OR CONDITIONS, EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OR CONDITIONS OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE. THESE WARRANTIES GIVE YOU
SPECIFIC LEGAL RIGHTS AND YOU MAY ALSO HAVE OTHER RIGHTS
WHICH VARY FROM JURISDICTION TO JURISDICTION. SOME
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF
EXPRESS OR IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION OR
LIMITATION MAY NOT APPLY TO YOU. IN THAT EVENT, SUCH
WARRANTIES ARE LIMITED IN DURATION TO THE WARRANTY
PERIOD. NO WARRANTIES APPLY AFTER THAT PERIOD.

Items Not Covered by Warranty
IBM does not warrant uninterrupted or error-free operation of a Machine.

Unless specified otherwise, IBM provides non-IBM machinesWITHOUT WARRANTIES
OF ANY KIND.

Any technical or other support provided for a Machine under warranty, such as assistance via
telephone with “how-to” questions and those regarding Machine set-up and installation, will be

provided WITHOUT WARRANTIES OF ANY KIND.

Warranty Service
To obtain warranty service for the Machine, contact your reseller or IBM. In the United States,
call IBM at 1-800-772-2227. In Canada, call IBM at 1-800-565-3344. You may be required to
present proof of purchase.

IBM or your reseller provides certain types of repair and exchange service, either at your location
or at a service center, to keep Machines in, or restore them to, conformance with their
Specifications. IBM or your reseller will inform you of the available types of service for a
Machine based on its country of installation. IBM may repair the failing Machine or exchange it
at its discretion.

When warranty service involves the exchange of a Machine or part, the item IBM or your reseller
replaces becomes its property and the replacement becomes yours. You represent that all
removed items are genuine and unaltered. The replacement may not be new, but will be in good
working order and at least functionally equivalent to the item replaced. The replacement assumes
the warranty service status of the replaced item.

Any feature, conversion, or upgrade IBM or your reseller services must be installed on a Machine
which is 1) for certain Machines, the designated, serial-numbered Machine and 2) at an
engineering-change level compatible with the feature, conversion, or upgrade. Many features,
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conversions, or upgrades involve the removal of parts and their return to IBM. A part that
replaces a removed part will assume the warranty service status of the removed part.

Before IBM or your reseller exchanges a Machine or part, you agree to remove all features, parts,
options, alterations, and attachments not under warranty service.

You also agree to

1. ensure that the Machine is free of any legal obligations or restrictions that prevent its
exchange;

2. obtain authorization from the owner to have IBM or your reseller service a Machine that you
do not own; and

3. where applicable, before service is provided
a. follow the problem determination, problem analysis, and service request procedures that

IBM or your reseller provides,
b. secure all programs, data, and funds contained in a Machine,
c. provide IBM or your reseller with sufficient, free, and safe access to your facilities to

permit them to fulfill their obligations, and
d. inform IBM or your reseller of changes in a Machine's location.

IBM is responsible for loss of, or damage to, your Machine while it is 1) in IBM's possession or
2) in transit in those cases where IBM is responsible for the transportation charges.

Neither IBM nor your reseller is responsible for any of your confidential, proprietary or personal
information contained in a Machine which you return to IBM or your reseller for any reason.
You should remove all such information from the Machine prior to its return.

Production Status
Each IBM Machine is manufactured from new parts, or new and used parts. In some cases, the
Machine may not be new and may have been previously installed. Regardless of the Machine's
production status, IBM's appropriate warranty terms apply.

Limitation of Liability
Circumstances may arise where, because of a default on IBM's part or other liability, you are
entitled to recover damages from IBM. In each such instance, regardless of the basis on which
you are entitled to claim damages from IBM (including fundamental breach, negligence,
misrepresentation, or other contract or tort claim), IBM is liable for no more than

1. damages for bodily injury (including death) and damage to real property and tangible
personal property; and

2. the amount of any other actual direct damages, up to the greater of U.S. $100,000 (or
equivalent in local currency) or the charges (if recurring, 12 months' charges apply) for the
Machine that is the subject of the claim.

This limit also applies to IBM's suppliers and your reseller. It is the maximum for which
IBM, its suppliers, and your reseller are collectively responsible.

UNDER NO CIRCUMSTANCES IS IBM LIABLE FOR ANY OF THE
FOLLOWING: 1) THIRD-PARTY CLAIMS AGAINST YOU FOR DAMAGES
(OTHER THAN THOSE UNDER THE FIRST ITEM LISTED ABOVE); 2)
LOSS OF, OR DAMAGE TO, YOUR RECORDS OR DATA; OR 3) SPECIAL,
INCIDENTAL, OR INDIRECT DAMAGES OR FOR ANY ECONOMIC
CONSEQUENTIAL DAMAGES (INCLUDING LOST PROFITS OR SAVINGS),
EVEN IF IBM, ITS SUPPLIERS OR YOUR RESELLER IS INFORMED OF
THEIR POSSIBILITY. SOME JURISDICTIONS DO NOT ALLOW THE
EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL
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DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT
APPLY TO YOU.

IBM Statement of Warranty Worldwide except Canada, Puerto
Rico, Turkey, United States (Part 1 - General Terms)

  

This Statement of Warranty includes Part 1 - General Terms and Part 2 - Country-unique Terms.
The terms of Part 2 may replace or modify those of Part 1. The warranties provided by IBM
in this Statement of Warranty apply only to Machines you purchase for your use, and not for
resale, from IBM or your reseller. The term “Machine” means an IBM machine, its features,
conversions, upgrades, elements, or accessories, or any combination of them. The term
“Machine” does not include any software programs, whether pre-loaded with the Machine,
installed subsequently or otherwise. Unless IBM specifies otherwise, the following warranties
apply only in the country where you acquire the Machine. Nothing in this Statement of Warranty
affects any statutory rights of consumers that cannot be waived or limited by contract. If you have
any questions, contact IBM or your reseller.

Machine - IBM 4X/8X/32X CD-ReWritable Internal IDE Option Kit

Warranty Period* - One Year

*Contact your place of purchase for warranty service information. Some IBM Machines are eligible
for On-site warranty service depending on the country where service is performed.

The IBM Warranty for Machines
IBM warrants that each Machine 1) is free from defects in materials and workmanship and 2)
conforms to IBM's Official Published Specifications. The warranty period for a Machine is a
specified, fixed period commencing on its Date of Installation. The date on your sales receipt is
the Date of Installation, unless IBM or your reseller informs you otherwise.

During the warranty period IBM or your reseller, if approved by IBM to provide warranty
service, will provide repair and exchange service for the Machine, without charge, under the type
of service designated for the Machine and will manage and install engineering changes that apply
to the Machine.

If a Machine does not function as warranted during the warranty period, and IBM or your reseller
are unable to either 1) make it do so or 2) replace it with one that is at least functionally
equivalent, you may return it to your place of purchase and your money will be refunded. The
replacement may not be new, but will be in good working order.

Extent of Warranty
The warranty does not cover the repair or exchange of a Machine resulting from misuse, accident,
modification, unsuitable physical or operating environment, improper maintenance by you, or
failure caused by a product for which IBM is not responsible. The warranty is voided by
removal or alteration of Machine or parts identification labels.

THESE WARRANTIES ARE YOUR EXCLUSIVE WARRANTIES AND
REPLACE ALL OTHER WARRANTIES OR CONDITIONS, EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OR CONDITIONS OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE. THESE WARRANTIES GIVE YOU
SPECIFIC LEGAL RIGHTS AND YOU MAY ALSO HAVE OTHER RIGHTS
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WHICH VARY FROM JURISDICTION TO JURISDICTION. SOME
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF
EXPRESS OR IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION OR
LIMITATION MAY NOT APPLY TO YOU. IN THAT EVENT, SUCH
WARRANTIES ARE LIMITED IN DURATION TO THE WARRANTY
PERIOD. NO WARRANTIES APPLY AFTER THAT PERIOD.

Items Not Covered by Warranty
IBM does not warrant uninterrupted or error-free operation of a Machine.

Unless specified otherwise, IBM provides non-IBM machinesWITHOUT WARRANTIES
OF ANY KIND.

Any technical or other support provided for a Machine under warranty, such as assistance via
telephone with “how-to” questions and those regarding Machine set-up and installation, will be

provided WITHOUT WARRANTIES OF ANY KIND.

Warranty Service
To obtain warranty service for the Machine, contact your reseller or IBM. You may be required
to present proof of purchase.

IBM or your reseller provides certain types of repair and exchange service, either at your location
or at a service center, to keep Machines in, or restore them to, conformance with their
Specifications. IBM or your reseller will inform you of the available types of service for a
Machine based on its country of installation. IBM may repair the failing Machine or exchange it
at its discretion.

When warranty service involves the exchange of a Machine or part, the item IBM or your reseller
replaces becomes its property and the replacement becomes yours. You represent that all
removed items are genuine and unaltered. The replacement may not be new, but will be in good
working order and at least functionally equivalent to the item replaced. The replacement assumes
the warranty service status of the replaced item.

Any feature, conversion, or upgrade IBM or your reseller services must be installed on a Machine
which is 1) for certain Machines, the designated, serial-numbered Machine and 2) at an
engineering-change level compatible with the feature, conversion, or upgrade. Many features,
conversions, or upgrades involve the removal of parts and their return to IBM. A part that
replaces a removed part will assume the warranty service status of the removed part.

Before IBM or your reseller exchanges a Machine or part, you agree to remove all features, parts,
options, alterations, and attachments not under warranty service.

You also agree to

1. ensure that the Machine is free of any legal obligations or restrictions that prevent its
exchange;

2. obtain authorization from the owner to have IBM or your reseller service a Machine that you
do not own; and

3. where applicable, before service is provided
a. follow the problem determination, problem analysis, and service request procedures that

IBM or your reseller provides,
b. secure all programs, data, and funds contained in a Machine,
c. provide IBM or your reseller with sufficient, free, and safe access to your facilities to

permit them to fulfil their obligations, and
d. inform IBM or your reseller of changes in a Machine's location.
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IBM is responsible for loss of, or damage to, your Machine while it is 1) in IBM's possession or
2) in transit in those cases where IBM is responsible for the transportation charges.

Neither IBM nor your reseller is responsible for any of your confidential, proprietary or personal
information contained in a Machine which you return to IBM or your reseller for any reason.
You should remove all such information from the Machine prior to its return.

Production Status
Each IBM Machine is manufactured from new parts, or new and used parts. In some cases, the
Machine may not be new and may have been previously installed. Regardless of the Machine's
production status, IBM's appropriate warranty terms apply.

Limitation of Liability
Circumstances may arise where, because of a default on IBM's part or other liability, you are
entitled to recover damages from IBM. In each such instance, regardless of the basis on which
you are entitled to claim damages from IBM (including fundamental breach, negligence,
misrepresentation, or other contract or tort claim), IBM is liable for no more than

1. damages for bodily injury (including death) and damage to real property and tangible
personal property; and

2. the amount of any other actual direct damages, up to the greater of U.S. $100,000 (or
equivalent in local currency) or the charges (if recurring, 12 months' charges apply) for the
Machine that is the subject of the claim.

This limit also applies to IBM's suppliers and your reseller. It is the maximum for which
IBM, its suppliers, and your reseller are collectively responsible.

UNDER NO CIRCUMSTANCES IS IBM LIABLE FOR ANY OF THE
FOLLOWING: 1) THIRD-PARTY CLAIMS AGAINST YOU FOR DAMAGES
(OTHER THAN THOSE UNDER THE FIRST ITEM LISTED ABOVE); 2)
LOSS OF, OR DAMAGE TO, YOUR RECORDS OR DATA; OR 3) SPECIAL,
INCIDENTAL, OR INDIRECT DAMAGES OR FOR ANY ECONOMIC
CONSEQUENTIAL DAMAGES (INCLUDING LOST PROFITS OR SAVINGS),
EVEN IF IBM, ITS SUPPLIERS OR YOUR RESELLER IS INFORMED OF
THEIR POSSIBILITY. SOME JURISDICTIONS DO NOT ALLOW THE
EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL
DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT
APPLY TO YOU.

Part 2 - Worldwide Country-Unique Terms

  

ASIA PACIFIC

AUSTRALIA:  The IBM Warranty for Machines: The following paragraph is added to this
Section:
The warranties specified in this Section are in addition to any rights you may have under the
Trade Practices Act 1974 or other legislation and are only limited to the extent permitted by the
applicable legislation.

Extent of Warranty: The following replaces the first and second sentences of this Section:
The warranty does not cover the repair or exchange of a Machine resulting from misuse, accident,
modification, unsuitable physical or operating environment, operation in other than the Specified
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Operating Environment, improper maintenance by you, or failure caused by a product for which
IBM is not responsible.

Limitation of Liability: The following is added to this Section:
Where IBM is in breach of a condition or warranty implied by the Trade Practices Act 1974,
IBM's liability is limited to the repair or replacement of the goods or the supply of equivalent
goods. Where that condition or warranty relates to right to sell, quiet possession or clear title, or
the goods are of a kind ordinarily acquired for personal, domestic or household use or
consumption, then none of the limitations in this paragraph apply.

PEOPLE'S REPUBLIC OF CHINA:  Governing Law: The following is added to this
Statement:
The laws of the State of New York govern this Statement.

INDIA:  Limitation of Liability:  The following replaces items 1 and 2 of this Section:
1. liability for bodily injury (including death) or damage to real property and tangible personal
property will be limited to that caused by IBM's negligence;
2. as to any other actual damage arising in any situation involving nonperformance by IBM
pursuant to, or in any way related to the subject of this Statement of Warranty, IBM's liability
will be limited to the charge paid by you for the individual Machine that is the subject of the
claim.

NEW ZEALAND:  The IBM Warranty for Machines: The following paragraph is added to
this Section:
The warranties specified in this Section are in addition to any rights you may have under the
Consumer Guarantees Act 1993 or other legislation which cannot be excluded or limited. The
Consumer Guarantees Act 1993 will not apply in respect of any goods which IBM provides, if
you require the goods for the purposes of a business as defined in that Act.

Limitation of Liability: The following is added to this Section:
Where Machines are not acquired for the purposes of a business as defined in the Consumer
Guarantees Act 1993, the limitations in this Section are subject to the limitations in that Act.

EUROPE, MIDDLE EAST, AFRICA (EMEA)

The following terms apply to all EMEA countries.

The terms of this Statement of Warranty apply to Machines purchased from an IBM reseller. If
you purchased this Machine from IBM, the terms and conditions of the applicable IBM
agreement prevail over this warranty statement.

Warranty Service
If you purchased an IBM Machine in Austria, Belgium, Denmark, Estonia, Finland, France,
Germany, Greece, Iceland, Ireland, Italy, Latvia, Lithuania, Luxembourg, Netherlands, Norway,
Portugal, Spain, Sweden, Switzerland or United Kingdom, you may obtain warranty service for
that Machine in any of those countries from either (1) an IBM reseller approved to perform
warranty service or (2) from IBM.

If you purchased an IBM Personal Computer Machine in Albania, Armenia, Belarus, Bosnia and
Herzegovina, Bulgaria, Croatia, Czech Republic, Georgia, Hungary, Kazakhstan, Kirghizia,
Federal Republic of Yugoslavia, Former Yugoslav Republic of Macedonia (FYROM), Moldova,
Poland, Romania, Russia, Slovak Republic, Slovenia, or Ukraine, you may obtain warranty
service for that Machine in any of those countries from either (1) an IBM reseller approved to
perform warranty service or (2) from IBM.

The applicable laws, Country-unique terms and competent court for this Statement are those of
the country in which the warranty service is being provided. However, the laws of Austria
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govern this Statement if the warranty service is provided in Albania, Armenia, Belarus, Bosnia
and Herzegovina, Bulgaria, Croatia, Czech Republic, Federal Republic of Yugoslavia, Georgia,
Hungary, Kazakhstan, Kirghizia, Former Yugoslav Republic of Macedonia (FYROM), Moldova,
Poland, Romania, Russia, Slovak Republic, Slovenia, and Ukraine.

The following terms apply to the country specified:

EGYPT:  Limitation of Liability: The following replaces item 2 in this Section:
2. as to any other actual direct damages, IBM's liability will be limited to the total amount you
paid for the Machine that is the subject of the claim.

Applicability of suppliers and resellers (unchanged).

FRANCE:  Limitation of Liability: The following replaces the second sentence of the first
paragraph of this Section:
In such instances, regardless of the basis on which you are entitled to claim damages from IBM,
IBM is liable for no more than: (items 1 and 2 unchanged).

GERMANY:  The IBM Warranty for Machines: The following replaces the first sentence of
the first paragraph of this Section:
The warranty for an IBM Machine covers the functionality of the Machine for its normal use and
the Machine's conformity to its Specifications.

The following paragraphs are added to this Section:
The minimum warranty period for Machines is six months.

In case IBM or your reseller are unable to repair an IBM Machine, you can alternatively ask for a
partial refund as far as justified by the reduced value of the unrepaired Machine or ask for a
cancellation of the respective agreement for such Machine and get your money refunded.

Extent of Warranty:  The second paragraph does not apply.

Warranty Service: The following is added to this Section:
During the warranty period, transportation for delivery of the failing Machine to IBM will be at
IBM's expense.

Production Status: The following paragraph replaces this Section:
Each Machine is newly manufactured. It may incorporate in addition to new parts, re-used parts
as well.

Limitation of Liability: The following is added to this Section:
The limitations and exclusions specified in the Statement of Warranty will not apply to damages
caused by IBM with fraud or gross negligence and for express warranty.

In item 2, replace “U.S. $100,000” with “1.000.000 DEM.”

The following sentence is added to the end of the first paragraph of item 2:
IBM's liability under this item is limited to the violation of essential contractual terms in cases of
ordinary negligence.

IRELAND:  Extent of Warranty: The following is added to this Section:
Except as expressly provided in these terms and conditions, all statutory conditions, including all
warranties implied, but without prejudice to the generality of the foregoing all warranties implied
by the Sale of Goods Act 1893 or the Sale of Goods and Supply of Services Act 1980 are hereby
excluded.

Limitation of Liability: The following replaces items one and two of the first paragraph of this
Section:
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1. death or personal injury or physical damage to your real property solely caused by IBM's
negligence; and 2. the amount of any other actual direct damages, up to the greater of Irish
Pounds 75,000 or 125 percent of the charges (if recurring, the 12 months' charges apply) for the
Machine that is the subject of the claim or which otherwise gives rise to the claim.

Applicability of suppliers and resellers (unchanged).

The following paragraph is added at the end of this Section:
IBM's entire liability and your sole remedy, whether in contract or in tort, in respect of any
default shall be limited to damages.

ITALY:  Limitation of Liability: The following replaces the second sentence in the first
paragraph:
In each such instance unless otherwise provided by mandatory law, IBM is liable for no more
than: (item 1 unchanged) 2)as to any other actual damage arising in all situations involving
non-performance by IBM pursuant to, or in any way related to the subject matter of this
Statement of Warranty, IBM's liability, will be limited to the total amount you paid for the
Machine that is the subject of the claim.

Applicability of suppliers and resellers (unchanged).

The following replaces the second paragraph of this Section:
Unless otherwise provided by mandatory law, IBM and your reseller are not liable for any of the
following: (items 1 and 2 unchanged) 3) indirect damages, even if IBM or your reseller is
informed of their possibility.

SOUTH AFRICA, NAMIBIA, BOTSWANA, LESOTHO AND SWAZILAND:  Limitation of
Liability: The following is added to this Section:
IBM's entire liability to you for actual damages arising in all situations involving nonperformance
by IBM in respect of the subject matter of this Statement of Warranty will be limited to the
charge paid by you for the individual Machine that is the subject of your claim from IBM.

TURKIYE:  Production Status: The following replaces this Section:
IBM fulfils customer orders for IBM Machines as newly manufactured in accordance with IBM's
production standards.

UNITED KINGDOM:  Limitation of Liability: The following replaces items 1 and 2 of the
first paragraph of this Section:
1. death or personal injury or physical damage to your real property solely caused by IBM's
negligence;
2. the amount of any other actual direct damages or loss, up to the greater of Pounds Sterling
150,000 or 125 percent of the charges (if recurring, the 12 months' charges apply) for the
Machine that is the subject of the claim or which otherwise gives rise to the claim.

The following item is added to this paragraph:
3. breach of IBM's obligations implied by Section 12 of the Sale of Goods Act 1979 or Section
2 of the Supply of Goods and Services Act 1982.

Applicability of suppliers and resellers (unchanged).

The following is added to the end of this Section:
IBM's entire liability and your sole remedy, whether in contract or in tort, in respect of any
default will be limited to damages.

NORTH AMERICA

CANADA:  Warranty Service: The following is added to this Section:
To obtain warranty service from IBM, call 1-800-565-3344.
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UNITED STATES OF AMERICA: Warranty Service: The following is added to this
Section:
To obtain warranty service from IBM, call 1-800-772-2227.
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 Notices

References in this publication to IBM products, programs, or services do not imply
that IBM intends to make these available in all countries in which IBM operates. Any
reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Subject to IBM’s valid
intellectual property or other legally protectable rights, any functionally equivalent
product, program, or service may be used instead of the IBM product, program, or
service. The evaluation and verification of operation in conjunction with other
products, except those expressly designated by IBM, are the responsibility of the user.

IBM may have patents or pending patent applications covering subject matter in this
document. The furnishing of this document does not give you any license to these
patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
 IBM Corporation

500 Columbus Avenue
 Thornwood, NY 10594
 U.S.A.
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 Trademarks

The following terms are trademarks of the IBM Corporation in the United States or
other countries or both:

Microsoft, Windows, and Windows NT are trademarks or registered trademarks of
Microsoft Corporation in the United States or other countries or both.

Intel and Pentium are trademarks of Intel Corporation in the United States or other
countries or both.

Other company, product, and service names may be trademarks or service marks of
others.

Extended Services HelpCenter IBM
Micro Channel OS/2  
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Electronic emission notices

IBM 4X/8X/32X CD-ReWritable Internal IDE Option Kit

Federal Communications Commission (FCC) Statement

Note: This equipment has been tested and found to comply with the limits for a Class
B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference in a residential installation.
This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instructions, may cause harmful interference
to radio communications. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause harmful interference to
radio or television reception, which can be determined by turning the equipment off
and on, the user is encouraged to try to correct the interference by one or more of the
following measures:

� Reorient or relocate the receiving antenna.
� Increase the separation between the equipment and receiver.
� Connect the equipment into an outlet on a circuit different from that to which the

receiver is connected.
� Consult an IBM authorized dealer or service representative for help.

Properly shielded and grounded cables and connectors must be used in order to meet
FCC emission limits. Proper cables and connectors are available from IBM authorized
dealers. IBM is not responsible for any radio or television interference caused by
using other than recommended cables and connectors or by unauthorized changes or
modifications to this equipment. Unauthorized changes or modifications could void
the user's authority to operate the equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) this device may not cause harmful interference, and (2)
this device must accept any interference received, including interference that may
cause undesired operation.

Responsible Party:

International Business Machines Corporation
New Orchard Road
Armonk, NY 10504

 Telephone: 1-919-543-2193

Tested To Comply
With FCC Standards

FOR HOME OR OFFICE USE

Industry Canada Class B emission compliance statement

This Class B digital apparatus complies with Canadian ICES-003.
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Avis de conformité à la réglementation d'Industrie Canada

Cet appareil numérique de classe B est conforme à la norme NMB-003 du Canada.

European Union - emission directive

This product is in conformity with the protection requirements of EU Council
Directive 89/366/ECC on the approximation of the laws of the Member States relating
to electromagnetic compatibility.

IBM can not accept responsibility for any failure to satisfy the protection requirements
resulting from a non-recommended modification of the product, including the fitting of
non-IBM option cards.

This product has been tested and found to comply with the limits for Class B
Information Technology Equipment according to CISPR 22 / European Standard EN
55022. The limits for Class B equipment were derived for typical residential
environments to provide reasonable protection against interference with licensed
communication devices.
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Union Europea - Normativa EMC
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